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1: Overview

INTRODUCTION

The SNAP PAC S-series programmable automation 
controllers provide powerful, real-time control and 
communication to meet your industrial control, 
monitoring, and data acquisition and exchange 
needs. As part of the Opto 22 SNAP PAC System, one 
of these compact, industrially hardened controllers 
can handle multiple control, automation, and data 
tasks involving digital and analog control, serial 
string handling, PID, and enterprise connectivity.

Connecting to Opto 22 serial- and Ethernet-based 
I/O systems, a SNAP PAC S-series controller runs 
control programs written in Opto 22’s PAC Control™ 
software to monitor and control a wide range of 
devices and equipment. SNAP PAC S-series 
controllers are well suited to original equipment 
manufacturers (OEMs), system integrators, and 
end-users in process control, discrete manufacturing, 
or hybrid industries and applications.

A SNAP PAC S-series controller simultaneously runs up to 32 PAC Control flowcharts, although a PAC Control 
strategy can actually contain a much larger number of flowcharts. The total number of flowcharts is limited 
only by the controller memory available for strategy storage.

Two S-series PACs of the same part number can be used together as redundant controllers. One controller 
runs the strategy while the other runs in tandem, ready to take over if the first one fails. 

Ethernet Communication

All SNAP PAC S-series programmable controllers communicate over standard 10/100 Mbps Ethernet networks 
and can be attached to an existing wired Ethernet network or wireless LAN (local area network). The 
controllers can also be used in an independent control network built with standard, off-the-shelf Ethernet 
hardware.

SNAP PAC S-series controllers include two 10/100 Mbps Ethernet interfaces for networking through an 
Ethernet switch to Ethernet hosts, as well as SNAP PAC brains and I/O, which provide local intelligence and the 
connections to digital and analog sensors and actuators as well as serial devices. These independent Ethernet 
ports have separate IP addresses that can be used with PAC Project™ Professional software to set up redundant 

SNAP-PAC-S2 
controller
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network links to safeguard the availability and reliability of an I/O system, or to segment a control system’s 
network from the enterprise LAN.

Supported protocols over Ethernet include EtherNet/IP™, Modbus®/TCP, SMTP, SNMP, FTP, and OptoMMP. 
• Using EtherNet/IP, SNAP PAC S-series controllers can share data with Allen-Bradley® Logix PLCs and other 

PLC systems based on the EtherNet/IP protocol. 
• Using Modbus/TCP, S-series PACs can share data with Ethernet-based Modbus hardware and software. 
• SMTP (Simple Mail Transfer Protocol) is used for email, and SNMP (Simple Network Management 

Protocol) lets the network monitor the PAC just as it would monitor network computer hardware. 
• FTP can be used to manipulate files and data in the PAC’s file system. 
• OptoMMP is an open, documented protocol used by all Opto 22 Ethernet-based controllers and brains.

Serial Communication

SNAP PAC S-series controllers provide RS-232 and RS-485 
communication as follows:
• The SNAP-PAC-S1 and SNAP-PAC-S1-FM [OBSOLETE] have 

two RS-232 serial ports that support general-purpose 
communication with serial devices; you can send and receive 
data from one or two serial devices connected directly to the 
controller. By default, Port 0 is set to be connected to a modem 
using Point-to-Point Protocol (PPP) for creating TCP/IP networks 
over serial or PSTN (Public Switched Telephone Network) lines. To 
connect Port 0 to serial devices, change the port configuration in 
PAC Manager. 
The S1 PACs also have one pluggable two-wire RS-485 port that 
can be used for SNAP PAC SB-series serial brains and legacy 
Opto 22 mistic™ I/O units, including the serial B3000 brain and 
remote mistic bricks.

• The SNAP-PAC-S2 has four serial ports that can each be 
configured using PAC Manager as either RS-232 or RS-485 (2-wire 
or 4-wire). These ports can be used for either I/O or 
general-purpose serial communication. Configured as RS-232, the ports support remote serial device 
communication, and any one of the ports can be configured as a PPP modem connection. Configured as 
RS-485, the serial ports connect to SNAP PAC serial brains and to mistic I/O units. 
If you have a substantial number of serial I/O units, the PAC S2 is the controller to use. For the default 
configuration settings of these ports, see “Assigning Serial Ports on SNAP-PAC-S2 Controllers” on page 26.

For additional serial interfaces, you can add one or more SNAP serial communication modules on attached 
SNAP Ethernet-based I/O units.

Backward Compatibility

S-series controllers have RS-485 serial interfaces for connecting to Opto 22’s legacy mistic I/O units. The 
SNAP-PAC-S1 and SNAP-PAC-S1-FM [OBSOLETE] have one RS-485 port, and the SNAP-PAC-S2 can be 
configured with up to four. 

This connectivity with legacy serial-based I/O systems, combined with PAC Control Professional’s ability to 
import control programs (or strategies) written in OptoControl™ software, provides a migration path to 
integrate older Opto 22 I/O systems into modern control hardware running on Ethernet networks. For detailed 
information on updating control strategies and integrating legacy control hardware into modern systems, see 
form 1692, FactoryFloor to PAC Project Migration Technical Note.

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3147
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Forward Compatibility

SNAP PAC S-series controllers are also compatible with newer groov EPIC processors and groov RIO edge I/O 
units, which add industrial IoT data communications and security features to your system. Both groov EPIC and 
groov RIO can be used as I/O units with an S-series controller. 

If you’re not using serial-based I/O units with your system and don’t require controller redundancy, consider 
purchasing a groov EPIC processor instead of a SNAP PAC S-series controller. For more information, see the 
groov EPIC system on our website or contact our pre-sales engineers.

I/O Unit Compatibility

The combination of Ethernet (both wired and wireless) and serial network interfaces gives SNAP PAC S-series 
controllers the ability to control current and many legacy Opto 22 I/O units. All S1s have one RS-485 port, and 
S2s can be configured with up to four. 

The following table lists I/O units supported by S-series controllers:

This connectivity with legacy serial-based I/O systems, combined with PAC Control Professional software’s 
ability to import control programs (or strategies) written in OptoControl™ software, provides a migration path 
to integrate older Opto 22 I/O systems into modern control hardware running on Ethernet networks.

For detailed information on updating control strategies and integrating legacy control hardware into modern 
systems, see the FactoryFloor to PAC Project Migration Technical Note (form 1692).

Redundant Controllers

Two identical SNAP PAC S-series controllers can be used in a redundant system, where one controller actively 
runs the control program and the other is ready to take over if the first one should fail. Besides two identical 
PACs, a redundant system requires PAC Project Professional R9.0 or newer (see “PAC Project Software,” below) 
and the SNAP PAC Redundancy Option Kit. 

The PAC Control Professional strategy developed for a redundant system makes use of special redundancy 
features, such as checkpoint blocks and persistent/redundant variables. The developer has complete flexibility 
in programming, tagging specific data for redundancy and placing checkpoint blocks at precise points in the 
logic where synchronization is to occur. 

See page 10 for a diagram of a redundant system. Also see the SNAP PAC Redundancy Option Kit Data Sheet 
(form 1901) and the SNAP PAC System Redundancy User’s Guide (form 1831).

S-Series Controller On an Ethernet Network On a Serial Network

SNAP-PAC-S1
SNAP-PAC-S1-FMa 

SNAP-PAC-S2

SNAP-PAC-R1
SNAP-PAC-R1-B

SNAP-PAC-R1-FMa 

SNAP-PAC-R2

SNAP-PAC-R2-FMa 

SNAP-PAC-EB1

SNAP-PAC-EB1-FMa 

SNAP-PAC-EB2

SNAP-PAC-EB2-FMa 

GRV-EPIC-PR1
GRV-EPIC-PR2

GRV-R7-MM1001-10
GRV-R7-MM2001-10
G4EB2
G4D32EB2
G4D32EB2-UPG
SNAP-UP1-ADS**
SNAP-B3000-ENET**
SNAP-ENET-D64**
SNAP-ENET-S64**
SNAP-ENET-RTC**

SNAP-PAC-SB1*
SNAP-PAC-SB2*
B3000**
B3000-B**
SNAP-BRS**
B100**
B200**
G4D16R**
G4D32RS**
G4A8R**

* For information about data transfer speed when using a controller to communicate with a serial brain, 
see page 37.
** Legacy I/O processors; not recommended for new development
a OBSOLETE product, please contact Pre-Sales Engineering for more information.

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3989
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4008
http://www.opto22.com/site/documents/drilldown.aspx?aid=3147
https://www.opto22.com/products/groov-epic-system
https://www.opto22.com/products/groov-epic-system
https://www.opto22.com/products/groov-rio
https://www.opto22.com/products/groov-rio
https://www.opto22.com/products/groov-epic-system
https://www.opto22.com/products/groov-epic-system
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PAC PROJECT SOFTWARE

SNAP PAC controllers use Opto 22’s PAC Project Microsoft® Windows®-compatible automation software for 
programming, human-machine-interface (HMI) development, and OPC connectivity. 

Two versions of PAC Project are available on our website, www.opto22.com: PAC Project Basic is free to 
download; PAC Project Professional is available for purchase and download.
• PAC Project Basic includes PAC Control™ for developing control programs, PAC Display™ for creating 

operator interfaces, and PAC Manager™ configuration software.
• PAC Project Professional adds expanded versions of PAC Control and PAC Display plus a SoftPAC 

software-based controller for PC-based control, OptoOPCServer™ software for exchanging data with OPC 
2.0-compliant client software applications, and OptoDataLink™ for exchanging SNAP PAC System data 
with databases (including Microsoft SQL Server, Microsoft Access, and MySQL), text files, and email 
systems).
You can also purchase PAC Control Professional, PAC Display Professional, SoftPAC, OptoOPCServer, and 
OptoDataLink separately. For details, see the PAC Project Data Sheet (form 1699).

PAC Control Basic is a graphical, flowchart-based programming tool for machine control and process 
applications. Using PAC Control, you create, download, and run strategies on a SNAP PAC or groov EPIC 
controller. In addition to flowchart programming with subroutine capability, PAC Control includes a powerful, 
built-in scripting language based on C and other procedural languages. 

PAC Control Professional adds the ability to import legacy OptoControl strategies, support for older mistic™ 
serial I/O units, and support for the dual independent Ethernet ports on a SNAP PAC controller. 

The number of PAC Control flowcharts that can simultaneously run depends on the controller, but the 
PAC Control strategy can contain a much larger number of flowcharts. The total number of flowcharts is 
limited only by the memory available for strategy storage.

PAC Display Basic is an intuitive HMI package for building operator interfaces, or projects, for communicating 
with a SNAP PAC controller. PAC Display offers a full-featured HMI including alarming, trending, and a built-in 
library of 3,000 industrial automation graphics. 

PAC Display Professional adds the ability to import projects created in OptoDisplay, part of the legacy 
Opto 22 FactoryFloor® software suite, and using redundant Ethernet communication links on SNAP PAC 
controllers. PAC Display Professional can also connect to Ethernet-based FactoryFloor controllers running 
OptoControl strategies.

SoftPAC is a software-based programmable automation controller (PAC)designed for PC-based control. 
Programmed just like an Opto 22 hardware controller, SoftPAC runs your PAC Control strategy independently 
on an embedded or standalone PC. SoftPAC takes advantage of a PC’s speed and file capabilities for 
applications requiring extended file storage, frequent access to files, or math-intensive processes. 

OptoOPCServer is a fast, efficient OPC 2.0-compliant server for communicating with many Opto 22 products, 
including SNAP PAC controllers and I/O units, plus legacy Opto 22 Ethernet-based controllers and I/O. Using 
OptoOPCServer, you can consolidate data from all these Opto 22 systems into the OPC client software of your 
choice, such as third-party HMI and data acquisition packages, and custom software applications you create 
with tools such as Visual C++®.

OptoDataLink is a software application that makes it easy to share data from the SNAP PAC System with 
commonly used databases, including Microsoft SQL Server, Microsoft Access, and MySQL, as well as text files. 
The I/O points and strategy variables already created in your PAC Control strategy are automatically available 
for OptoDataLink to use for data exchange.

PAC Manager is a utility application for assigning IP addresses to SNAP PAC controllers and brains, reading or 
changing basic controller configuration, and configuring and testing I/O. 

For information about documentation, see page 12.

https://www.opto22.com/products/pacprojectbas
https://www.opto22.com/support/resources-tools/documents/1699-pac-project-data-sheet
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FOR DEVELOPERS: SNAP PAC REST API

If you’re a developer who’d like to use PAC Control strategy tags in communications with other 
devices, the Opto 22 SNAP PAC REST API is a secure and powerful way to do just that. The API is 
available in SNAP PAC R-series and S-series controllers with PAC firmware R9.5a and higher. To 
configure HTTPS access to your PAC’s RESTful server and learn how to call the API, visit 
developer.opto22.com.

ARCHITECTURAL DIAGRAMS

Because SNAP PAC S-series controllers have multiple Ethernet and serial interfaces, these controllers are 
suitable for use in a variety of system layouts and architectures. Dual independent Ethernet interfaces, for 
example, let you configure a network for link redundancy or segmented networking. A PPP serial interface 
provides a dial-up modem link for remotely located control systems, while two-wire RS-485 support integrates 
existing Opto 22 mistic serial-based I/O units into contemporary Ethernet-based systems. 

Basic Control System

In this basic system, the SNAP-PAC-S1 controls several SNAP PAC I/O units, some on a wired Ethernet network 
and some on a serial network. PAC Project Basic is all you need.

PC used to develop the PAC 
Control strategy. After 
development, the strategy 
is downloaded to the 
controller and runs 
independently.

PC running
PAC Display HMI 
(operator interface)

SNAP-PAC-S1 controller 
running the PAC Control 
strategy and controlling all 
I/O units, both Ethernet 
and serial

SNAP PAC EB brains 
providing distributed 
control on an 
Ethernet network

SNAP PAC SB brains providing 
distributed control on a serial 
network

http://developer.opto22.com/
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Isolating Ethernet Networks into Zones

This diagram shows multiple Opto 22 SNAP I/O units connected together over an Ethernet network and 
controlled by a SNAP PAC S-series controller running a control strategy. The controller is also connected to a 
larger, separate enterprise Ethernet network to provide data to two PCs running Opto 22’s PAC Display HMI 
software and OptoOPCServer.

Sitting between the two networks, the SNAP PAC S-series controller isolates I/O and control traffic on the 
trusted network from the untrusted enterprise network, and vice versa.

For this system, PAC Display must be configured to access the I/O through the controller rather than directly 
from the I/O units, since they are on a separate network. 

PC running 
OptoOPCServer and 

OptoDataLink

PC running PAC Display 
Professional

Ethernet switch, 
network #1

Ethernet switch, 
network #2

Enterprise Network

Control Network

SNAP PAC S-series controller communicates with host 
computers through one network interface and controls I/O 
with other devices through the other interface, isolating 
trusted and untrusted networks into zones.

I/O units are controlled by the controller 
on an isolated segment.

Sensors and actuators, 
location #1

Sensors and actuators, 
location #2
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Connections to Legacy Serial-based I/O Units

In the following diagram, a SNAP PAC S-series controller is connected to Opto 22 legacy serial-based I/O units 
over an RS-485 serial network. The controller is also connected to a larger, separate enterprise Ethernet 
network to provide process data to a PC running Opto 22’s PAC Display HMI software.

PC running PAC 
Display Professional

Ethernet 
switch

PC running PAC 
Control Professional

SNAP PAC S-series controller 
controls all I/O units.

I/O units are connected via a 2-wire RS-485 serial network and are 
running the mistic protocol. Each I/O unit is connected to its own 
group of sensors and actuators, and all I/O units are controlled by the 
SNAP PAC S-series controller.

RS-485 serial 
network

Sensors and actuators, 
location #1

Sensors and actuators, 
location #2

Sensors and actuators, 
location #3
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SNAP-PAC-S2 Connections to Serial-based I/O Units

The following diagram shows a SNAP-PAC-S2 controller connected to multiple Opto 22 serial-based I/O units 
over two RS-485 serial networks, a remote a SNAP Ethernet-based I/O unit over a modem using the 
Point-to-Point Protocol (PPP), and a serial-based industrial scale.

Sensors and actuators, 
location #3

Sensors and actuators, 
location #4

Sensors and actuators, 
location #5

Sensors and actuators, 
location #1

Sensors and actuators, 
location #2

PC running PAC 
Display Professional

PC running PAC 
Control Professional

Scale

RS-485 serial networks
SNAP-PAC-S2 controller controls all 
I/O units and processes data from 
the scale.

I/O units are connected via a 2-wire RS-485 serial network and are controlled by the SNAP PAC S-series 
controller. Each I/O unit is connected to its own group of sensors and actuators.

Ethernet switch

Modem

Modem

PPP connection

PPP connection
to SNAP-PAC-R1
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Ethernet Link Redundancy

The following diagram shows a SNAP PAC S-series controller connected to two separate Ethernet network 
links. This configuration addresses the concern that an Ethernet network may fail or need maintenance, 
leaving the PC running OptoOPCServer, the PC running PAC Display, the controller, and the I/O units unable to 
communicate. In this configuration, if one link goes down, devices can still communicate on the other. Each 
PC has two network interface cards (NICs), and the SNAP PAC S-series controller and the I/O units 
(SNAP-PAC-R1 and -R2 controllers) have two network interfaces as well. 

For an example of controller redundancy, see the following page.

PC with two NICs running PAC 
Display Professional

PC with two NICs running 
OptoOPCServer

I/O units are all connected by the controller. Each 
I/O unit is connected to its own group of sensors 
and actuators, but all are connected to the same 
two networks.

SNAP PAC S-series 
controller controls all 
I/O units.

SNAP PAC R-series 
controller

Sensors and actuators, 
location #2

Sensors and actuators, 
location #1

Opto 22 Redundant Network

Ethernet switch, 
network #2

Ethernet switch, 
network #1

SNAP PAC R-series 
controller
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Controller Redundancy

In this diagram, two S-series controllers are operating redundantly. One is the active controller, while the other 
acts as a backup, ready to take over should the first one fail. 

Controller redundancy requires PAC Project Professional R9.0 or newer and the Redundancy Option Kit, which 
includes the arbiter and the redundant power switch in the diagram below. PAC Redundancy Manager, a 
software utility for setting up and maintaining the system, is included in PAC Project Pro. The two controllers 
you use must be exactly the same part number (for example, two SNAP-PAC-S2 controllers). 

As you can see, one advantage of an Opto 22 redundant system is that it uses standard PACs, standard cabling, 
and standard I/O. Another advantage is that either controller can act as the active or backup controller; you 
can switch their roles at any time for maintenance, for example. For detailed information on redundancy, see 
the SNAP PAC System Redundancy User’s Guide (form 1831).

SNAP PAC I/O units

Ethernet switch

Redundant power switch

Arbiter

SNAP PAC controller

SNAP PAC controller

PC running PAC Project Professional

RS-485

Power control Power

Ethernet crossover 
cable connects the 
PAC S2s on ENET2

RS-485

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4008
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Remote Host and I/O Unit Connections Using PPP

For remote monitoring and control, you can use a SNAP PAC S-series controller to connect to a remote host 
such as a PC or to a SNAP Ethernet-based I/O unit using a dial-up link. For this use, the controller 
communicates using the Point-to-Point Protocol (PPP) over a modem.

PC running 
OptoOPCServer and 
OptoDataLink

PC running PAC 
Display Professional

Ethernet switch

Dial-up modem at 
remote location

Enterprise Network

SNAP PAC S-series controller uses a 
PPP dial-up telephone connection to 
communicate with I/O units at a 
remote location.

SNAP I/O unit at remote 
location is connected to 
sensors and actuators.

Sensors and actuators at 
remote location

Dial-up 
modem
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ABOUT THIS GUIDE

See the following sections for basic information on setting up and maintaining a SNAP PAC S-series controller:

Chapter 2: Quick Start—installing and configuring SNAP PAC S-series controllers.

Chapter 3: Maintenance and Troubleshooting—troubleshooting problems while installing or using the 
SNAP-PAC-S1 controller on an Ethernet or serial network; getting device information, loading new firmware, 
changing the controller’s IP address, and other maintenance procedures.

Appendix A: Technical Specifications—specifications, connectors, indicators, pinouts, and dimensions.

RELATED DOCUMENTATION

You’ll find most of the documentation to build and maintain your control system in the PAC Project folder 
that’s added to your Windows Desktop when you install PAC Project. While using PAC Project applications, you 
can get online help by clicking Help in the menu bar or the Help buttons in dialog boxes, or simply by pressing 
the F1 key. 

Here's a brief list of documents you may find helpful. You can also download other documents, sample files, 
software utilities, technical notes, integration kits, and much more from the Opto 22 website.

TIP: To easily find documents on our website, search on the form number. 

For this information See this guide Form #

Assigning IP addresses, loading new firmware, 
configuring SNAP I/O points and system functions

PAC Manager User’s Guide1 1704

Designing flowchart-based control programs for the 
system 

PAC Control User’s Guide1 1700

PAC Control Command Reference1 1701

PAC Control Commands Quick Reference 1703

Securely accessing data in the PAC via its REST API developer.opto22.com –

Programming your own applications by using either:
• The OptoMMP protocol for memory-mapped 

controllers and brains
• One of the OptoMMP Software Development Kits 

(SDKs) 

OptoMMP Protocol Guide 1465

Using redundant controllers SNAP PAC System Redundancy User’s Guide 1831

Installing and using SNAP PAC S-series controllers SNAP PAC S-series Controller User’s Guide 1592

Installing and using SNAP PAC R-series controllers SNAP PAC R-series Controller User’s Guide 1595

Installing and using SNAP PAC EB- and 
SB-series brains

SNAP PAC Brains User’s Guide 1690

Communicating with I/O units using OPC OptoOPCServer User’s Guide 1439

Communicating with I/O units using Modbus/TCP Modbus/TCP Protocol Guide 1678

Communicating with I/O units using EtherNet/IP EtherNet/IP for SNAP PAC Protocol Guide 1770

Moving to the SNAP PAC System with older 
hardware and software

SNAP PAC System Migration Technical Note 1688

1 If you are using a SNAP PAC controller with legacy I/O units (for example, mistic I/O units or Ultimate I/O), 
use the Legacy versions of these documents instead:
•Legacy Edition, PAC Control User’s Guide, form 1710
•Legacy Edition, PAC Control Command Reference, form 1711
•Legacy Edition, PAC Manager User’s Guide, form 1714

https://www.opto22.com/support/resources-tools
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
https://www.opto22.com/support/resources-tools/documents/1701-pac-control-command-reference
https://www.opto22.com/support/resources-tools/documents/1703_pac_control_commands_quick_reference-pdf
http://developer.opto22.com/
https://www.opto22.com/support/resources-tools?keyword=optommp%20software%20development%20kit%20sdk&rt=2&tag=&numres=25&tp=0&page=1
https://www.opto22.com/support/resources-tools?keyword=optommp%20software%20development%20kit%20sdk&rt=2&tag=&numres=25&tp=0&page=1
https://www.opto22.com/support/resources-tools/documents/1465-optommp-protocol-guide
https://www.opto22.com/support/resources-tools/documents/1831-snap-pac-redundancy-option-user-s-guide
https://www.opto22.com/support/resources-tools/documents/1592-snap-pac-s-series-users-guide
https://www.opto22.com/support/resources-tools/documents/1595-snap-pac-r-series-users-guide
https://www.opto22.com/support/resources-tools/documents/1690-snap-pac-brains-users-guide
https://www.opto22.com/support/resources-tools/documents/1439-optoopcserver-user-s-guide
https://www.opto22.com/support/resources-tools/documents/1678-modbus-tcp-protocol-guide
https://www.opto22.com/support/resources-tools/documents/1770_ethernet_ip_for_snap_pac_protocol_guide-pdf
http://www.opto22.com/site/documents/drilldown.aspx?aid=3149
https://www.opto22.com/support/resources-tools/documents/1710-legacy-edition-pac-control-user-s-guide
https://www.opto22.com/support/resources-tools/documents/1711-legacy-edition-pac-control-command-reference
https://www.opto22.com/support/resources-tools/documents/1714-pac-manager-users-guide-legacy-edition


CHAPTER 1: OVERVIEW

SNAP PAC S-Series User’s Guide 13

FOR HELP

If you have problems installing or using a SNAP PAC S-series controller and cannot find the help you need in 
this guide, contact Opto 22 Product Support. 

Phone: 800-TEK-OPTO (800-835-6786 toll-free 
in the U.S. and Canada)
951-695-3080
Monday through Friday, 
7 a.m. to 5 p.m. Pacific Time

Email: support@opto22.com

Opto 22 website: www.opto22.com

When calling for technical support, you can help us help you faster if you provide the following information to 
the Product Support engineer:
• A screen capture of the Help > About dialog box showing software product and version (available by 

clicking Help > About in the application’s menu bar). 
• Opto 22 hardware part numbers or models that you’re working with.
• Firmware version:

– For groov EPIC processors and groov RIO modules: available in groov Manage by clicking Info and 
Help > About.

– For SNAP controllers and brains: available in PAC Manager by clicking Tools > Inspect.
• Specific error messages you received.
• Version of your computer’s operating system.
• For PAC Control, PAC Display, OptoOPCServer, or PAC Manager, you may be requested to provide 

additional information, such as log or dump files. You can find these files in a support files sub-folder:
a. On your Windows Desktop, double-click the PAC Project 10.4 folder.
b. Double-click Support Files.
c. Double-click on the appropriate shortcut to open the sub-folder containing the requested files.

Note: PAC Control, PAC Display, OptoOPCServer, and PAC Manager create appropriate sub-folders when they 
create diagnostic log or dump files. If they have not created these files, the sub-folder may not exist; in this case, 
the shortcut will not work.

NOTE: Email messages and phone calls 
to Opto 22 Product Support are 
grouped together and answered in the 
order received.

mailto:support@opto22.com
https://www.opto22.com
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2: Quick Start

WHAT YOU WILL NEED
• PC running Microsoft® Windows® 10 Professional or Windows 7 Professional (32-bit or 64-bit), with a 

10/100 MB Ethernet interface, the TCP/IP protocol installed, and a valid IP address, on the same subnet as 
the controller

• Crossover cable (for direct connection to the PC) or an available connection to a standard 10BASE-T or 
100BASE-TX Ethernet network

• SNAP PAC S-series controller
• 8–32 VDC power supply (see “Power Supply Recommendations” on page 15 for specific information and 

recommendations)
• Small flathead screwdriver
• One or more of the following, depending on your I/O system requirements:

– Opto 22 SNAP PAC, groov EPIC, or groov RIO I/O units on the same Ethernet network as the 
controller.

– Opto 22 legacy SNAP Ethernet-based I/O units—SNAP Simple I/O, SNAP Ethernet I/O, or SNAP 
Ultimate I/O units—on the same Ethernet network as the controller.

– Opto 22 RS-485 serial-based I/O units—SNAP PAC serial brains, serial B3000, SNAP-BRS, B100/B200 
brains, or mistic remote bricks (G4D16R, G4D32RS, G4A8R)—on a two-wire RS-485 network.

• (Recommended) PAC Project Basic or PAC Project Professional (available from the Opto22 website)

POWER SUPPLY RECOMMENDATIONS

Opto 22 recommends that the SNAP PAC S-series controller be powered with an Opto 22 SNAP-PS24 or 
SNAP-PS24U power supply. In place of one of these power supplies, Opto 22 recommends an 8-32 VDC linear 
supply with adequate current ratings for the load. For more information on power requirements, see Appendix 
A: Technical Specifications.

Change to SNAP-PAC-S1 Power Input Range

Current SNAP-PAC-S1 controllers have an 8–32 VDC input range, but earlier SNAP-PAC-S1 controllers use an 
8–24 VDC input range. Before applying power to the controller, confirm that the input voltage is 
within the voltage range shown on the faceplate.

The voltage input rating can also be determined based on the SNAP-PAC-S1’s serial number as follows:
• SNAP-PAC-S1 controllers with serial number 500000 and higher have an 8–32 VDC voltage input rating.
• SNAP-PAC-S1 controllers with serial numbers lower than 500000 have an 8–24 VDC input rating. Using 

an input voltage above this range will cause damage that is not covered by the warranty.

https://www.opto22.com/search?searchtext=pacproject&searchmode=anyword
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The SNAP-PAC-S1 serial number appears on the sticker on the side of the unit. The input voltage rating is 
shown on the top cover of the controller.

INSTALLING HARDWARE

NOTE: If you are using redundant controllers, see steps in the SNAP PAC System Redundancy User’s Guide (form 1831).

1. Install Opto 22 I/O units according to instructions in the device’s user’s guide.1 
2. Choose a convenient mounting location for the SNAP PAC S-series controller and either panel-mount or 

DIN-rail mount it according to the diagrams on page 27 and page 29.
3. Confirm that the power supply to be used with the controller is turned off or unplugged, and discharge 

any residual charge that may remain in the power supply.
4. With the power supply off or unplugged, connect the power supply to the controller.

CAUTION: Reversing wire polarity may cause damage to your controller. This damage is not covered by Opto 22’s 
warranty. If you are not certain about the polarity of the wires on your power supply, check with a meter.

a. With the power supply off or unplugged, connect the + (positive) lead from the power supply 
(normally red) to the + (positive) terminal on the face of the controller. 

b. Connect the COM wire from the power supply (normally black) to the – (negative) terminal on the 
face of the controller.

c. Connect a lead from a known chassis ground to the  (ground) terminal on the face of the 
controller. 

IMPORTANT: Do not turn on power to the controller.

5. Using Category 5 or superior solid unshielded twisted-pair cable, connect the SNAP PAC S-series 
controller in one of the following ways:
– Connect to a PC directlyusing Ethernet port ENET 1. S-series Ethernet interfaces support Auto 

MDI-X, which means you can use a standard straight-through Ethernet cable; a crossover cable is 
not needed for direct connection to a PC. 

– Connect to a standard 10BASE-T or 100BASE-TX Ethernet network that has a PC on the same subnet 
as the controller and does NOT have a Dynamic Host Configuration Protocol (DHCP) server. 

Maximum cable or segment length is 100 meters; minimum cable length is one meter. 

NOTE: When connecting the controller to a managed switch, make sure the managed switch's port 
configuration is set to Auto for the Duplex setting and Auto for the Speed setting.

6. If the controller will connect to I/O units on an RS-485 serial network, connect the serial cable following 
the instructions in “RS-232 and RS-485 Serial Networking” below.

IMPORTANT: Do not turn on power to the controller.

SNAP-PAC-S1 input 
voltage rating

SNAP-PAC-S1 serial 
number

IP Address IP Address
MAC 1: MAC 1: 

CC
50102

1 You can download user’s guides, data sheets, and other helpful documents from our website at www.opto22.com. 

https://www.opto22.com/support/resources-tools/documents/1831-snap-pac-redundancy-option-user-s-guide
https://www.opto22.com/support/resources-tools?keyword=&rt=1&tag=&numres=25&tp=0&page=1
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7. Before turning on power to the controller, follow steps in the PAC Manager User’s Guide (form 1704) to 
assign the controller an IP address. Note that you can use PAC Manager to assign IP addresses to the 
controller and I/O units at the same time. 

RS-232 AND RS-485 SERIAL NETWORKING

SNAP PAC S-series controllers provide both RS-232 and RS-485 serial communication interfaces. For serial 
communication ports and their corresponding wiring pinouts, see “Connectors, Indicators, and Pinouts” on 
page 20.

RS-232 Connections

You can use the RS-232 ports on a SNAP PAC S-series controller to:
• Direct connect to a device that supports RS-232 communication.
• Connect to a modem and make a serial Point-to-Point Protocol (PPP) connection to a remote PC or other 

device that supports PPP.

Use PAC Manager to configure the RS-232 ports for the way you want to use them. (For instructions, see the 
PAC Manager User’s Guide, form 1704.) Note that the controller cannot make a direct RS-232 serial connection 
with an Opto 22 I/O unit; however, it is possible to connect to an Opto 22 I/O unit that supports PPP 
communications.

Attaching a Modem to the Controller

To work properly with the SNAP PAC S-series controller, a modem must be able to store settings in 
non-volatile RAM (NVRAM) and default to those settings on reset.

IMPORTANT: Any modem used with the controller must implement the Carrier Detect (CD) signal or use a custom 
cable that connects CD to Data Terminal Ready (DTR).

1. Connect the modem to the controller using a modem cable with female DB-9 connector. If necessary, 
see “Connectors, Indicators, and Pinouts” on page 20 for pinout details.

2. Store configuration settings to the modem’s NVRAM, following instructions in the user’s guide for your 
modem. 

NOTE: Configuration settings must be stored to the modem’s NVRAM so they will be loaded when the controller 
sends a reset command to the modem. 

RS-485 Connections

You can use an RS-485 serial port on a SNAP PAC S-series controller to connect to Opto 22 I/O units on a 
two-wire, RS-485 serial network. These I/O units include SNAP PAC SB-series brains, serial B3000 brains, and 
mistic remote bricks such as the G4D16R, G4D32RS, and the G4A8R. Both the PAC S1 and PAC S2 support 
optional mistic signal interrupts. In addition, on the SNAP-PAC-S2 controller you can use PAC Manager to 
configure up to four RS-485 ports either as 2-wire or 4-wire connections.

Bias and Termination

Bias: Bias the RS-485 network at one location (device) only.  This is typically done at the device that is the 
RS-485 master, which is normally the controller.

Termination: Configure termination at the devices that are located at both ends of the RS-485 network. For 
more information, please see the appropriate data sheet or user’s guide for configuring the I/O unit or brain 
that is at the end of the link.

https://www.opto22.com/support/resources-tools?keyword=1704&rt=1&tag=&numres=25&tp=0&page=1
https://www.opto22.com/support/resources-tools?keyword=1704&rt=1&tag=&numres=25&tp=0&page=1
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NOTE: Bias and termination settings on S-series controllers take effect immediately.

Configuring RS-485 Connections on SNAP-PAC-S1 Controllers

RS-485 bias and termination settings are configured 
using two DIP switches located on the top of the 
controller.

Configuring RS-485 Connections on SNAP-PAC-S2 Controllers

The serial ports on SNAP-PAC-S2 controllers are software configurable using PAC Manager. This includes 
mode, termination, and bias. For more information, see the PAC Manager User’s Guide (form 1704). See also, 
“Assigning Serial Ports on SNAP-PAC-S2 Controllers” on page 26.

Wiring the 10-pin Serial Connector on SNAP-PAC-S1 Controllers

Serial ports1 and 2 on SNAP-PAC-S1 controllers share a 10-pin pluggable connector (Phoenix Contact, part 
number FK-MC 0.5 - 2.5, supplied with the controller). When inserting and removing wire leads into this 
connector, do the following:
1. Completely depress the small orange tab for the 

appropriate opening with a small screwdriver.
2. While holding the tab down with the screwdriver, 

insert or remove the wire as needed.
3. Release the orange tab.

For a pinout of the connector, see “Connectors, 
Indicators, and Pinouts” on page 20.

SNAP PAC S-series controller 
location on RS-485 network

RS-485 
termination

Termination 
Active

Termination 
Inactive

Switch Position Description

BIAS
ENABLE Bias: active

DISABLE Bias: inactive

TERM
ENABLE Termination: active

DISABLE Termination: inactive

DIP switches

(Portion of top view

At the End

In the Middle
(floating)

Hole

Orange 
tab

Pin 1

https://www.opto22.com/support/resources-tools?keyword=1704&rt=1&tag=&numres=25&tp=0&page=1
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Wiring the 7-pin Serial Connector on SNAP-PAC-S2 Controllers

Each of the four serial ports on SNAP-PAC-S2 controllers uses a 
7-pin pluggable connector supplied with the controller (EBY part 
number EB1381M-07-500 or equivalent). Using the screws on the 
side of the connector, insert or remove the wires as needed.

For a pinout of this connector, see “Connectors, Indicators, and 
Pinouts” on page 20.

CAUTION: Do not use communication port connectors from a legacy 
OptoControl controller*. Legacy connectors will fit in a SNAP-PAC-S2, 
but the pin orientation is different. Instead, use the connectors 
supplied with the SNAP-PAC-S2 controller.

Guidelines for Grounding SNAP PAC Brains and Controllers

Power supply side: The DC output of the power supply to the I/O unit (or controller) should be "floating,” 
which means the negative output terminal is not tied to ground.

RS-485 serial cable side: Connect the signal common from the controller to the signal common on each of 
the I/O units using an insulated wire that is part of the serial cable. Though sometimes hard to find, there are 
cables that have a twisted pair for serial communication plus an additional insulated wire for common. 
However, it might be easier to obtain a cable that has an extra twisted pair and then use one of the wires from 
this extra pair for the signal common connections.

NOTE: Make sure there are enough wires in the cable for a separate insulated signal common wire. Do not connect 
the signal common wire to chassis ground. Do not use the overall cable shield drain wire as the signal common.

Connect the cable shield drain wire of the serial cable to chassis ground at one location only. If the shield is not 
continuous from one I/O unit to the next, then the shield of each segment will need to be tied to chassis 
ground at one location only per segment.

*Legacy OptoControl Controllers

G4LC32
G4LC32SX
G4LC32ISA

G4LC32ISA-LT
M4
M4IO

M4RTU
SNAP-LCM4
SNAP-LCSX/PLUS

Pin 1

Use one of the wires from an 
extra twisted pair for the signal 
common

Connect the cable 
shield drain wire to 
chassis ground 

RS-485 data pair
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CONNECTORS, INDICATORS, AND PINOUTS

SNAP-PAC-S1 and SNAP-PAC-S1-FM [OBSOLETE]

Status and Activity LEDs

Indicator Description

S0
RS-232 serial activity 
on port 0

S1
RS-232 serial activity 
on port 1

S2 RS-485 serial activity

STAT
Startup status and 
control program oper-
ational status

ACT
Ethernet network 
activity

LINK
Link established with 
Ethernet network

Port 0 for RS-232 serial
(DB-9 connector)

Pin Description
Signal

Direction

1 DCD In

2 RX In

3 TX Out

4 DTR Out

5 COM

6 DSR In

7 RTS Out

8 CTS In

9 RI* In

* RI signal does not occur on 
PACs with a microSD card slot

Ports 1 and 2 for RS-485 
and RS-232 serial

Pin Description
Signal

Direction

P
o

rt
 2

 f
o

r 
R

S
-4

85
 s

e
ri

a
l

(2
-W

ir
e)

1 TX/RX+ In/Out

2 TX/RX– In/Out

3 SIG COM*

4 IRQ+ In

5 IRQ– In

P
o

rt
 1

 f
o

r 
R

S
-2

32
 s

er
ia

l 6 TX Out

7 RX In

8 GND

9 RTS Out

10 CTS In

* Isolated ground

Independent 10/100 Mbps Ethernet 
interfaces (RJ-45 connectors)

8–32 VDC input power
(pluggable 3-pin connector)

Port 0 for RS-232 serial
communications (DB-9 connector)
with handshaking. Supports PPP by default; 
for use with serial devices, configure the port 
in PAC Manager.

Port 1 for RS-232 serial 
communications (pins 6–10 of
pluggable 10-pin connector)

Port 2 for RS-485 serial 
communications (pins 1–5 of 
pluggable 10-pin connector)

DIP switches for RS-485 serial link

Controller reset button

STAT LED

Activity LED (Yellow)

Link LED (Green)

MicroSD card slot

Bias
Termination
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SNAP-PAC-S2

Status and Activity LEDs

Indicator Description

TX0/RX0 Serial activity on port 0

TX1/RX1 Serial activity on port 1

TX2/RX2 Serial activity on port 2

TX3/RX3 Serial activity on port 3

STAT
Startup status and control 
program operational status

ACT Ethernet network activity

LINK
Link established with Ether-
net network

RS-485 and RS-232 Ports1

Pin RS-232
Signal

Direction
RS-485

Signal
Direction

1 TX Out TX/RX+ In/Out

2 RX In TX/RX– In/Out

3 COM2 COM2

4 RTS Out RX+ (4 wire) In

5 CTS In RX- (4 wire) In

6 DTR Out IRQ+ In

7 DCD In IRQ– In

1 CAUTION: Do not use communication port connectors from a 
legacy OptoControl controller*. Legacy connectors will fit in a 
SNAP-PAC-S2, but the pin orientation is different. Instead, use the 
connectors supplied with the SNAP-PAC-S2 controller.
2 Isolated ground. (Each channel is isolated from the others.)

*Legacy OptoControl Controllers:

G4LC32
G4LC32SX
G4LC32ISA

G4LC32ISA-LT
M4
M4IO

M4RTU
SNAP-LCM4
SNAP-LCSX/PLUS

Independent 10/100 Mbps Ethernet 
interfaces (RJ-45 connectors)

8–32 VDC input power
(pluggable 3-pin connector)

Ports 0 - 3 are each software 
configurable as either 
RS-232 (TX, RX, COM, DTR, DCD RTS, 
CTS), or
RS-485 (2-wire, 4-wire, optional 
termination, optional biasing).
Configure ports in PAC Manager.

Controller reset button

STAT LED

Activity LED (Yellow)

Link LED (Green)

Serial activity LEDs

Serial activity LEDs

MicroSD card slot
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PAC S1 SERIAL WIRING DIAGRAMS

NOTE: SNAP-PAC-S1 controllers support only 2-wire RS-485.

Make sure to verify the location of pin 1, which is 
indicated on the controller with a label or a small triangle. 
To be certain of pin 1’s locations, insert the connector into 
the controller and then mark the location of pin 1 on the 
connector itself.

Wiring a PAC S1 Controller to SB-Series Brains

Wiring a PAC S1 Controller to B3000 mistic Brains with an Interrupt Line

Pin 1

TX/RX +
TX/RX –
COM

TX/RX +
TX/RX –
COM

2-wire termination, end of link
Switches 3 & 2 OFF
Switch 1 ON1 

2 
3

O
N

1 
2 

3

O
N 2-wire, middle of link

All switches OFF

Chassis GND

TX/RX +
TX/RX –
COM

1
2
3
4
5
6
7
8
9
10

PAC S1

PAC SB PAC SB

Chassis GND

TX/RX +
TX/RX –
COM +
IRQ +
IRQ –

1
2
3
4
5
6
7
8

PAC S1

B3000 B3000

NOTE: To set bias and termination on a 
B3000-B, see Opto 22 form 1927, 
Configuring the B3000-B.

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3990
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PAC S2 SERIAL WIRING DIAGRAMS

Make sure to verify the location of pin 1, which is indicated on 
the controller with a label or a small triangle. To be certain of 
pin 1’s locations, insert the connector into the controller and 
then mark the location of pin 1 on the connector itself.

Brains in the middle of the link should not be biased or 
terminated. The devices at both ends of the network 
should be terminated. In addition, the RS-485 link 
should be biased at one location only, which is typically 
at the controller.

PAC S2 Controller to B3000 mistic Brains with an Interrupt Line

Pin 1

B3000 B3000
Chassis GND

TX/RX +
TX/RX –
COM

IRQ +
IRQ –

Two-wire

1
2
3
4
5
6

PAC S2

NOTE: To set bias and termination on 
a B3000-B, see form 1927, 
Configuring the B3000-B.

B3000 B3000
Chassis GND

Four-wire

PAC S2

4
5
3
1
2
6

RX+
RX-
COM
TX/RX +
TX/RX –
IRQ+

NOTE: The connector pins on an 
actual SNAP-PAC-S2 are in a 
different order than shown 
here.

NOTE: To set bias and termination on a 
B3000-B, see Configuring the 
B3000-B (form 1927).

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3990
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3990
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3990
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PAC S2 Controller to G4 mistic Bricks

To locate pin 1 on the PAC S2, see page 23.

See also, “Connectors, Indicators, and Pinouts” on page 20.

SBTA connected to a 
G4 mistic brick

COM
TX +

IRQ +
IRQ –

PAC S2 to SBTA

3
1
2
4
5
6

PAC S2

NOTE: For termination information, see the 
Mistic Installation Guide (form 595).

COM

TH

IRQ

G4TERM connected to a 
G4 mistic brick

TX +
TX –
IRQ +
IRQ –

PAC S2 to G4TERMR or G4TERML

1
2
6
7
3
4

PAC S2

TH+
TH–
IRQ+
IRQ–
COMCOM

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=1613
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PAC S2 Controller to PAC SB-Series Brains

To locate pin 1 on the PAC S2, see page 23.

See also, “Connectors, Indicators, and Pinouts” on page 20.

1 
2 

3

O
N

1 
2 

3

O
N

Two-wire

2-wire termination, end of link
Switches 3 & 2 OFF
Switch 1 ON

2-wire, middle of link All 
switches OFF

Chassis GND

TX/RX +
TX/RX –
COM

TX/RX +
TX/RX –
COM

TX/RX +
TX/RX –
COM

1
2
3
4
5
6
7

PAC S2

PAC SB PAC SB

Four-wire

TX/RX +
TX/RX -
COM

RX -
RX +

TX/RX +
TX/RX -
COM

RX -
RX +

4-wire termination, end of link
Switch 3 OFF
Switches 2 & 1 ON1 

2 
3

O
N

4-wire, middle of link
All switches OFF

RX +
RX –
COM

TX/RX –
TX/RX +

Chassis GND

NOTE: The connector pins on an actual SNAP-PAC-S2 are in 
a different order than shown here.

1 
2 

3

O
NPAC S2

PAC SB PAC SB

4
5
3
1
2
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ASSIGNING AN IP ADDRESS

See instructions in the PAC Manager User’s Guide (form 1704) to assign IP addresses to the SNAP PAC S-series 
controller using a wired Ethernet connection. (If you are using redundant controllers, use the PAC Redundancy 
Manager utility instead of PAC Manager. The PAC Redundancy Manager is part of PAC Project Professional R9.0 
and higher.

SNAP PAC controllers have two independent Ethernet network interfaces, labeled on the top of the controller 
as ENET1 and ENET2. Wired+Wireless PACs have a third network interface for the wireless LAN. You can use 
these separate interfaces to segment the control network from the company network or for other purposes. 
Use PAC Manager to assign the secondary and wireless addresses and configure settings. Make sure each 
interface is on a separate IP subnet and receives a unique IP address. 

ASSIGNING SERIAL PORTS ON SNAP-PAC-S2 CONTROLLERS

See instructions in the PAC Manager User’s Guide (form 1704), to configure serial ports for SNAP-PAC-S2 
controllers.

Each of the four serial ports on a SNAP-PAC-S2 can be configured either as an RS-232 serial port or an RS-485 
serial port. Up to four ports on the SNAP-PAC-S2 can be used for I/O, and up to four ports can be used for 
general purpose serial communication. Only one port on the SNAP-PAC-S2 can be used for PPP 
communication.

By default the serial ports are as follows:

Port Factory Default Mode

0 RS-232 (PPP)

1 RS-232 (not PPP)

2 RS-485 (2-wire 485 with termination and bias)

3 RS-485 (2-wire 485 with termination and bias)

http://www.opto22.com/site/documents/drilldown.aspx?aid=3161
http://www.opto22.com/site/documents/drilldown.aspx?aid=3161
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MOUNTING THE CONTROLLER

The SNAP PAC S-series controller can be panel mounted or mounted on a DIN rail. DIN-rail mounting requires 
an adapter clip, part number SNAP-PSDIN (not included).

Panel Mounting and Dimensions

Use two screws on each side of the SNAP-PAC-S1 controller to 
mount it to a panel. 

SNAP-PAC-S1 and SNAP-PAC-S1-FM [OBSOLETE]
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Panel Mounting and Dimensions (continued)

Use one screw on each side of the SNAP-PAC-S2 
controller to mount it to a panel.

SNAP-PAC-S2
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DIN-Rail Mounting and Dimensions

DIN-rail mounting requires an adapter clip, part number SNAP-PSDIN 
(not included). 

For DIN-rail mounting, remove the four screws that fasten the panel 
mounting base plate to the controller. Save screws. Remove the base 
plate.

Use the four screws to fasten the DIN-rail adapter clip to the bottom 
of the controller, as shown.

Optional DIN-rail 
adapter clip

SNAP-PAC-S1 and SNAP-PAC-S1-FM [OBSOLETE]
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DIN-Rail Mounting and Dimensions (continued)

SNAP-PAC-S2 

DIN-rail mounting requires an adapter clip, part number 
SNAP-S2DIN (not included).

For DIN-rail mounting, remove the four screws that fasten the 
panel mounting base plate to the controller. Save screws. 
Remove the base plate.

Use the four screws to fasten the DIN-rail adapter clip to the 
bottom of the controller, as shown.
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ABOUT THE CONTROLLER’S MEMORY MAP

Like SNAP Ethernet-based brains, a SNAP PAC S-series controller uses a memory mapped system for storing 
data and making that data available to other devices on the Ethernet network. This data includes 
configuration data, status information about the controller itself, and PAC Control strategy variable data that 
may be needed by a peer on the network.

Although SNAP PAC S-series controllers are designed to run PAC Control strategies, you can also write your 
own software applications to communicate with the controller’s memory map, either instead of or in addition 
to using PAC Control. You can use the OptoMMP Communication Toolkit or the IEEE 1394-based protocol for 
writing your applications. Both are explained in the OptoMMP Protocol Guide (form 1465) which also includes 
complete details of the memory map. Although this guide is written for I/O units, you can use the same 
information for a SNAP PAC S-series controller. Just be aware that many sections do not apply, since the 
controller’s memory map doesn’t include any I/O point or related information.

The SNAP PAC S-series controller’s memory map includes only the following areas:

Using Data for Peer-to-Peer Communication

Scratch Pad areas within the SNAP PAC S-series controller’s memory map provide a way for other devices on 
the Ethernet network to access data in the controller. For descriptions of the Scratch Pad areas—bits, integers, 
floats, and strings—see the PAC Manager User’s Guide (form 1704). For help in using PAC Control commands to 
access Scratch Pad areas, see “I/O Unit—Scratch Pad Commands” in the PAC Control User’s Guide (form 1700).

If you are not using PAC Control but writing your own software applications to access the Scratch Pad areas, 
see the OptoMMP Protocol Guide. This guide is written primarily for I/O units, but much of the same 
information on programming applies to SNAP PAC S-series controllers. The Scratch Pad areas of the memory 
map are described in the programming guide’s appendix. 

If you’re communicating between an Allen-Bradley Logix-based PLC and an S-series PAC, see the EtherNet/IP 
for SNAP PAC Protocol Guide (form 1770).

WHAT’S NEXT?

Your controller is now ready for use.
• To create PAC Control strategies to run on the controller, see the PAC Control User’s Guide (form 1700) and 

the PAC Control Command Reference (form 1701). Both are available for download from the Opto 22 
website at www.opto22.com.

• To securely access data from I/O points and variables in the PAC’s control strategy, visit 
developer.opto22.com, where you’ll find instructions to set up the PAC’s HTTP/HTTPS server and 
complete documentation for the RESTful API.

• See the PAC Manager User’s Guide (form 1704) for instructions to work with:
– Secondary network interfaces and port configuration
– File system and FTP
– Security settings

Status Area Read
Communications Port Configuration
Date and Time Configuration
Status Area Write
Security Configuration
Scratch Pad

PPP Configuration
PPP Status
microSD Card
IP Settings
WLAN Configuration
WLAN Status

http://www.opto22.com/site/documents/drilldown.aspx?aid=1875
http://developer.opto22.com/
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
http://www.opto22.com/site/documents/drilldown.aspx?aid=3165
http://www.opto22.com/site/documents/drilldown.aspx?aid=3164
https://www.opto22.com
http://www.opto22.com/site/documents/drilldown.aspx?aid=3161
https://www.opto22.com/support/resources-tools/documents/1770_ethernet_ip_for_snap_pac_protocol_guide-pdf
https://www.opto22.com/support/resources-tools/documents/1770_ethernet_ip_for_snap_pac_protocol_guide-pdf
https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
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3: Maintenance and 
Troubleshooting

To troubleshoot problems that may have occurred, see “Troubleshooting,” below.

For maintenance information about the SNAP PAC S-series controller, see the section “Maintaining the 
Controller” on page 38.

TROUBLESHOOTING

If you encounter a problem while installing or using the SNAP PAC S-series controller, check the information in 
this section. To contact Opto 22 Product Support, see “For Help” on page 13.

Checking Power

When troubleshooting any problem with your controller, first check that the required power is correctly 
supplied.

IMPORTANT: The current version of the SNAP PAC S-series standalone controller requires 8–32 VDC power, not the 
5 VDC power used by previous SNAP controllers and controller/brains. If you are replacing an older SNAP controller or 
controller/brain with a SNAP PAC S-series controller, make sure that 8–32 VDC power is supplied. Note that S-series 
controllers with serial numbers below 500,000 use 8–24 VDC. 

1. Review the information in “Power Supply Recommendations” on page 15 and the power requirements 
listed in Appendix . Confirm that the power supply used with the SNAP PAC S-series controller meets 
these requirements.

2. Confirm that all leads connected to the controller and the power supply are securely attached. These 
connections are described in “Installing Hardware” on page 16.

3. Verify that the controller’s ground terminal is connected to a known chassis ground as described in 
“Installing Hardware” on page 16.

4. Confirm that two Phillips-head screws are installed on the wide sides of the case, one screw per side. 
(These screws secure and ground the controller’s internal components.)

Communicating on an Ethernet Network

If you attempt to connect to the controller using its IP address and you cannot, first check the following:
• Make sure the controller has been turned on, the STAT LED is lit and not blinking, and the LNK LEDs for 

the connected Ethernet interfaces are lit. (See LED information on pages “Connectors, Indicators, and 
Pinouts” on page 20.)

• Verify that you typed in the correct address for the controller. Check the label on the side of the controller, 
where the IP address should be written.
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• Make sure the controller has been assigned a valid IP address and subnet mask. SNAP PAC S-series 
controllers come from the factory with a default IP address of 0.0.0.0, which is invalid. The default subnet 
mask is 255.255.255.0. To assign IP address and subnet mask, see the PAC Manager User’s Guide 
(form 1704).

• Make sure you have up-to-date drivers installed on your computer’s Network Interface Card (NIC). 
Contact your system administrator or the manufacturer of the card for help.

• Make sure any firewall in the computer (such as the built-in firewall in Windows 10) is temporarily 
disabled before you try to assign or change IP addresses, load firmware using PAC Manager’s 
Maintenance window, or work with files on the controller. BootP and FTP cannot function through a 
firewall in the PC. Firewalls in a router are less likely to be a problem unless certain ports (such as FTP 
client) have been blocked, either by default or on purpose.

Pinging the Controller

If you still cannot communicate with the controller after you have checked these items, try to reach it using 
the PING application.
1. Choose StartRun and type cmd to open a command prompt. 
2. At the prompt, type: ping [controller’s IP address]

For example, type: ping 10.192.54.40
At this point be sure to check for other devices on the Ethernet network that may have the same IP 
address.

If the controller responds, go to “Maintaining the Controller” on page 38.

If the PING command cannot be found, choose StartControl PanelNetwork. Make sure TCP/IP is 
configured as a protocol and that an IP address and subnet mask are assigned. 

If you see the message “Destination host route not defined,” the controller probably has an 
inappropriate IP address and subnet mask. Make sure the IP address and subnet mask on the controller are 
compatible with those on the computer. Follow directions in the PAC Manager User’s Guide (form 1704) to 
check the IP address and subnet mask on the controller and change them if necessary.

If you see the message “No response from host,” check the following:
• Are the computer and controller correctly connected? Is the controller turned on?
• Are the IP address and subnet mask on the controller compatible with those on the computer?
• Is the controller in bootloader mode? (If the reset button is held down for too long, the controller will 

enter bootloader mode, which is indicated by the STAT LED blinking seven times quickly.)

If you still cannot ping the controller, contact Opto 22 Product Support. (See “For Help” on page 13 for 
contact information.)

Solving Network Problems

If there are recurring problems in communicating with the controller, check your network. The wires, switches, 
and other parts in your Ethernet network are not part of the Opto 22 hardware, but any problems in your 
network may affect communication with Opto 22 products. 

Create a Network Diagram

First, create a network diagram and verify the following:
• Cable connectors are firmly inserted.
• The switch has power. Switch LEDs indicate that the connection is up. 
• Neither the PC nor the controller unit uses the switch’s uplink port.
• The controller’s LNK LED is lit.

https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
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Check Ethernet Errors

Next, use PAC Manager to check any Ethernet errors reported. These errors indicate network problems. You 
will need to know the controller’s IP address. 
1. Choose StartProgramsOpto 22PAC Project SoftwarePAC Manager. 
2. In the PAC Manager main window, click the Inspect icon .
3. In the IP Address field, type the IP address of the controller. Click Status Read. 
4. Scroll down until you see the items Ethernet Errors: Late Collisions, Ethernet Errors: Excessive Collisions, 

and Ethernet Errors: Others.

All three of these items should have a value of zero. If any of these items has a value other than zero, you may 
have a network problem. 

Analyze Communication Packets

If it appears that you have network problems, Opto 22 recommends using the open-source network protocol 
analyzer (or “packet sniffer”) Wireshark (www.wireshark.org) to log and analyze network communication 
packets on your network. 

Have Your Network Certified

If you suspect network problems, you may need to have your network professionally certified. Opto 22 does 
not offer network validation or certification services, but many network hardware manufacturers do. Contact 
the manufacturer of your Ethernet network hardware to have them diagnose, fix, and certify your network. 

If you continue to have problems communicating with the controller or I/O units after your network is 
certified, contact Opto 22 Product Support. (See “For Help” on page 13.)

TCP Settings

Retransmit timeout (RTO) refers to the length of time the controller waits while communicating before timing 
out. The RTO is determined by the controller’s TCP/IP stack, and the stack continually recalculates the RTO 

Ethernet Errors



TROUBLESHOOTING

SNAP PAC S-Series User’s Guide36

based on recent network traffic. If the network becomes busier, for example, the stack automatically adjusts 
the RTO to a higher value. 

If the TCP/IP stack times out while trying to transmit data, it doubles the current RTO and tries again. This 
process continues for five retries; after that, the controller stops trying and sends a timeout message. 

If you are receiving frequent timeout messages from the SNAP PAC S-series controller, you can change the TCP 
parameters in PAC Manager. 
1. Choose StartProgramsOpto 22PAC Project SoftwarePAC Manager. 
2. In the PAC Manager main window, click the Inspect icon .
3. In the IP Address field, type the IP address of the controller. Click Status Write.

CAUTION: Note the following recommended settings: 

If you set these fields too low, you may not be able to communicate with the controller at all, even though PAC 
Manager, to fix the settings. Then you would have to reset the controller to factory defaults.

4. Change these four fields as necessary:
TCP Minimum Retransmission Timeout sets an absolute minimum value for the RTO. The controller’s 
calculated RTO will never go below this value.
TCP Initial Retransmission Timeout sets the RTO for the first communication try. Be careful: since all 
future tries are based on this value, if you set it too low for network conditions, a connection will never be 
made.
TCP Retransmission Attempts sets the number of times the controller retries communication. Larger, 
busier networks need a higher number of retransmits than smaller networks with less traffic.
TCP Idle Session Timeout sets how long (in milliseconds) the controller allows a session to remain 
open without any activity. After this time, the controller closes the unused session. The default is 240,000 
milliseconds, or four minutes.

5. Click the Apply button to write your changes to the controller. 
6. In the Operation Commands list, highlight Store configuration to flash. Click Send Command.
7. In the Operation Commands list, highlight Restart I/O Unit from powerup. Click Send Command.

The new TCP parameters are set.

TCP Minimum Retransmission Timeout (msec): 250
TCP Initial Retransmission Timeout (msec): 3000
TCP Retransmission Attempts: 5
TCP Idle Session Timeout (msec): 240,000
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Communicating on a Serial Network

If a SNAP PAC S-series controller fails to connect using either an RS-232 serial interface for PPP host 
communication or an RS-485 serial interface for I/O unit communication, check the following:

Indicators—Depending on the port(s) being used on a SNAP-PAC-S1 controller, LED S0, S1, or S2 should be 
red (for receive data) and green (for transmit data). On a SNAP-PAC-S2, there are separate LEDs for Transmit 
and Receive for each port. Green indicates activity.

Power—Make sure that both the controller and the device it is connected to have been turned on.

Physical Connections—Check that the connectors on each end of the serial link are firmly attached to the 
controller and the other connected device.

RS-232 Configuration—RS-232 communication on a SNAP PAC S-series controller is configured using PAC 
Manager software, and ports must be configured correctly for their use, or they won’t work. See “Configuring 
Direct Communication to Serial Devices” in the PAC Manager User’s Guide (form 1704). 

NOTE: Port 0 is set by default to communicate using PPP. If you’re connecting to serial devices with Port 0, you must 
change its configuration in PAC Manager. 

RS-485 Configuration—On a SNAP-PAC-S1, RS-485 serial network bias and termination are configured 
using DIP switches on the top of the unit. Confirm that DIP switches are set to the correct positions for the 
controller’s location in the RS-485 network. See “RS-485 Connections” on page 17 for information. On a 
SNAP-PAC-S2, all port configuration is performed using PAC Manager. For details, see the PAC Manager User’s 
Guide (form 1704).

Timeout Errors when Communicating with a Serial Brain

• To avoid timeout issues when communicating from a controller to a serial brain, you should configure 
matching turnaround delays in both the controller and the brain. (Turnaround delays are typically 
required at 9600 baud—and sometimes needed at higher baud rates when your RS-485/422 bus is using 
repeaters.) 
– Configure the controller's turnaround time in PAC Manager > Tools > Inspect > Status Write button 

> Turn-Around Delay for Port <#> (msec). 
<#> represents the port number that the controller is using to connect to the brain.

– Configure the same turnaround time for the brain in PAC Manager > Tools > Inspect > Status Write 
button > Turn-Around Delay for Port <#> (msec).

The amount of turnaround time you'll need depends on the RS-485 cable connecting the devices 
(turnaround time increases with the length of the cable). Start with a 1 millisecond delay, and then, if 
you're still experiencing issues, increase the turnaround time until the connection is satisfactory.

• If you get a timeout error when trying to establish communication between an S-series controller and a 
serial brain (for example, a SNAP-PAC-SB2), the problem could be configuration-related.
– If you get the error when trying to run a PAC Control strategy, make sure that the baud rate on the 

brain's Baud Rate Switch is the same as the baud rate configured in your PAC Control strategy (File > 
Strategy Options > Serial I/O Ports tab). For example, if the brain's baud rate is set at 115,200 Kbs, 
then the serial I/O (RS-485) port in your strategy must also be configured for 115,200 Kbs.

– If you get a timeout error when using PAC Manager to communicate with the brain via a controller:
a. Check that the baud rate setting on the brain is the same as the baud rate configured in PAC 

Manager (Tools > Inspect > Communications > PPP Configure > Serial Port Speed).
b. If that doesn't solve the problem, then make sure the brain's baud rate setting is the same as the 

baud rate in the controller's strategy (File > Strategy Options > Serial I/O Ports tab). 
When you've configured the same baud rate for the brain, the strategy, and PAC Manager, you then 
need to cycle power to the controller. Cycling power releases a lock previously put on the 
configured communication port, and allows the new connection to succeed.

https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
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MAINTAINING THE CONTROLLER

Backup Battery

SNAP-PAC-S1 controllers with a serial number of 625654 or higher, and all SNAP-PAC-S2 controllers, have a 
rechargeable battery that receives charging current whenever the brain has power. It will retain data for up to 
one year with the power off.

SNAP-PAC-S1 controllers with a serial number of 625653 or lower have a user-replaceable 3.6-volt TL 5242 /W 
lithium battery that will retain data for a minimum of 10 years. Replacement part number is G4BATT32. 

Getting Device and Firmware Information

If you need to contact Opto 22 Product Support for assistance in using a controller, it is helpful to have device 
and firmware information at hand before you call. 
1. Choose StartProgramsOpto 22PAC Project SoftwarePAC Manager. 
2. In the PAC Manager main window, click the Inspect icon .
3. In the IP Address field, type the IP address of the device. Click Status Read.

This example shows a SNAP-PAC-S1; other devices are similar.

Keep this window open on your screen when you call Product Support. See the note on the next page.

NOTE: Because the Status Read area is used for both standalone controllers and Ethernet-based I/O units, some 
items apply to some devices and not others. The following items do not apply to standalone controllers:

Degrees F/C
Comm Watchdog Time (msec.)
Scanner Flags
Digital Scan Counter
Analog Scan Counter

PID Loops
Smart Modules Present
Arcnet data
Digital resets and failures since powerup
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For detailed information about items in the Status Read area, see the PAC Manager User’s Guide (form 1704).

Changing the Controller’s IP Address

If you know the SNAP PAC S-series controller’s IP address, see the PAC Manager User’s Guide (form 1704) 
for instructions to change it. (If you are using redundant controllers, use the PAC Redundancy Manager instead 
of PAC Manager.)

If you do not know the IP address, first check the label on the side of the controller in case the IP address 
has been written there. If you still don’t know the controller’s IP address, reset the controller to factory default 
settings following the instructions in “Resetting the Controller” on page 39 and then set the IP address as 
described in the PAC Manager User’s Guide.

Resetting the Controller

1. Carefully insert a straightened paperclip or stiff wire into the small hole labeled RESET. Inside the hole you 
can feel the paperclip push down on a button that resets the controller.

CAUTION: Do not power on the controller while holding down the reset button. This will deactivate battery 
power, which will cause the loss of contents in battery-backed RAM and stop the real-time clock.

2. Depending on the type of reset you need, press and hold down the reset button as described below. DO 
NOT hold the button down too long.

NOTE: Do not reset the brain to hardware test mode unless Opto 22 Product Support tells you to.

Reset type How to use the reset button What happens Notes

Simple reset Press and release immediately

Controller restarts. 
Any files and the strategy are erased unless they 
have been stored to flash memory. Archived strate-
gies are not erased.

Restore factory 
defaults

Press just until STAT LED turns 
solid green (1-2 sec)

Controller restarts.
If a microSD card is present and contains config-
uration, firmware, and/or strategy files—Files on 
the microSD card overwrite what is in flash memory 
and other files in flash memory are not erased. 
Data files on the card are not affected.*
If no microSD card is present containing configu-
ration, firmware, or strategy files—All files, strategy, 
archived strategy, persistent variables, and I/O con-
figuration are erased from RAM and flash memory, 
and IP addresses are reset to 0.0.0.0 and subnet 
masks to 255.255.255.0.

If no microSD card is 
present containing config-
uration, firmware, or strat-
egy files, you must 
reassign the IP address 
and subnet mask.

Failsafe bootloader 
mode

Press and wait while LED turns 
solid green. Release when LED 
starts to blink (2-5 sec)

Controller restarts. 
Any files and the strategy are erased unless they 
have been stored to flash memory. Archived strate-
gies are not erased.

Cycle power to recover. 
Result is the same as a 
simple reset.

Hardware test mode
Press and hold until LED starts 
blinking orange rapidly and con-
tinuously (> 5 sec)

Controller restarts.
Any files, strategy, archived strategy, and persistent 
variables in RAM and flash memory are erased. I/O 
configuration in flash is erased (R-series).
Data files on a microSD card are not affected.
IP addresses are reset to 0.0.0.0 and subnet masks 
to 255.255.255.0.

To recover, restore to fac-
tory defaults as described 
above. You also must 
reassign the IP address 
and subnet mask.

* Example of Restoring factory defaults when a microSD card is present: Suppose the card contains a firmware file but no configuration 
or strategy files. Restoring to factory defaults will leave the controller with the firmware from the card and configuration and strategy files 
from flash memory. You will not have to reassign an IP address or download a strategy.

https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
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Loading New Firmware

Each SNAP PAC S-series controller contains firmware (sometimes referred to as the kernel), which is similar to 
an operating system. If the firmware should become damaged, or if a new version of the firmware is released, 
you can load new firmware to the controller following instructions in the PAC Manager User’s Guide. You can 
also load new firmware via the microSD card, if the controller has one. See “Updating Firmware” on page 48.

CAUTION: Loading new firmware deletes your PAC Control strategy (even if stored to flash memory) and your 
persistent variables. Make sure you have archived your strategy before loading new firmware. 

Using the microSD Card Slot

SNAP PAC controllers with a manufacturing date code of 11/08 (November 2008) and newer 
have a microSD card slot in the top of the controller’s case. On a controller with a microSD card 
slot, the STAT LED blinks briefly about once every five seconds, indicating that the controller is 
checking to see if a card is in place.

IMPORTANT: Since the first release, card behavior has changed. If you are using firmware older 
than R9.0a, follow the instructions in Using microSD with Older Controller Firmware Technical Note (form 2018) 
instead of this document.

To determine firmware version, see page 43. To download the latest firmware (recommended), go to 
www.opto22.com/site/downloads and filter by Firmware. 

Card Type and Format

Use only cards with the microSD or microSDHC logos (shown above right). Also, be aware that card capacity, 
formatting, and filename limits vary depending on your controller, its firmware and loader, and the card type 
you are using: 

IMPORTANT: Minimum controller firmware version R9.4a and loader version R6.1a are required to use microSDHC 
cards. For more information, see OptoKnowledgeBase article KB83929. 

MicroSD/SDHC Card Uses 

Note minimum requirements in the table above. The card can be used for several purposes:
• To store data or files, which you can access using PAC Control commands or an FTP client. (PAC Manager 

cannot be used to access data, because it cannot see the card’s directory.)
• To quickly commission a replacement controller in the unlikely event that a controller fails.
• To update firmware on the controller. The card provides a convenient way to update firmware on 

non-networked controllers. It’s also useful if PAC Manager is not available to update firmware.
• To temporarily boot the controller from firmware on the microSD card rather than from the firmware in 

the controller, for example to test new firmware.

Controller firmware
Compatible 

cards
Card format

Max card 
capacity

Filename limits

Firmware 9.4a or higher 
and loader 6.1a or higher

microSDHC FAT32 32 GB Long names OK

microSD FAT32 or FAT16 2 GB Long names OK

R9.0a to R9.3e microSD FAT16 2 GB 8 dot 3*

Lower than R9.0** microSD FAT16 2 GB 8 dot 3*

* All files stored on the microSD card must be named with a maximum of eight characters in the name 
plus three characters in the extension (8 dot 3 format), for example: datafile.txt
** The card behaves differently using firmware lower than R9.0. Follow the instructions in Using 
microSD with Older Controller Firmware Technical Note (form 2018) instead of this document.

https://www.opto22.com/support/resources-tools/documents/using-microsd-with-older-controller-firmware-techn
http://www.opto22.com/site/downloads/dl_downloads.aspx?cid=0 
https://www.opto22.com/support/resources-tools/documents/using-microsd-with-older-controller-firmware-techn 
https://www.opto22.com/support/resources-tools/documents/using-microsd-with-older-controller-firmware-techn 
http://www.opto22.com/site/knowledgebase/kb_view_article.aspx?aid=2375
http://www.opto22.com/site/knowledgebase/kb_view_article.aspx?aid=2375
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
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• To update, run, or test new PAC Control strategies if the controller is not on the network, if PAC Control 
isn’t available, or if you want to test a new strategy without erasing the existing one.

The following table summarizes how to use the card; see the page in the last column for steps. 

To do this When Put card in... Use this method See pg

Store/access data Anytime

Controller

Automate data storage and retrieval in PAC 
Control logic: Use PAC Control commands and 
file communication handles. Or use PAC Con-
trol FTP communication handles.

42
Controller1 From a PC, use an FTP client. 

PC with card 
reader

Use Windows Explorer.

Replace failed 
controller using a 
prepared card

In advance

Controller1

PC with card 
reader

1. Use PAC Manager Inspect window to store IP 
address and configuration data to card.
2. Use PAC Control to make controller down-
load (.cdf) file. 
3. Create a command file to load firmware.
4. Copy .cdf file, command file, and firmware file 
to card. 

44

If controller 
fails

Controller

1. Replace failed controller with a new one 
(must be exactly same part number; must have 
minimum firmware R9.x and loader R6.x).
2. Insert prepared card and turn on power.
3. Use controller’s Reset button to reset to 
defaults from card. Strategy is saved to flash 
memory. 

Try out controller 
firmware without 
replacing current 
firmware

In advance
Controller1 or 
PC with card 
reader

Use Windows Explorer or FTP client to copy 
new firmware to card.

48

To use Controller

Insert prepared card into controller and cycle 
power. Controller runs firmware on card. 
To go back to older firmware, remove card and 
cycle power again.

Try out new strategy 
without replacing 
current strategy4

In advance
Controller1 or 
PC with card 
reader

Use PAC Control to make controller download 
(.cdf) file; then use Windows Explorer or FTP 
client to put .cdf file on the card.

49

To use Controller

Insert prepared card into controller and cycle 
power. Controller runs strategy from card. 
To go back to older strategy, remove card and 
cycle power again.

Update non-net-
worked controller 
with new firmware4

In advance
PC with card 
reader

Create command file; copy it and the firmware 
file to card. 

46

To use Controller
Insert card into controller. Controller runs firm-
ware from card until reset. Use controller’s 
Reset button to save firmware to flash.2

Update non-net-
worked controller 
with new strategy4

In advance
PC with card 
reader

Use PAC Control to make controller download 
(.cdf) file; then use Windows Explorer to copy 
.cdf file to the card.

49

To use Controller

Insert card into controller and cycle power. Con-
troller runs new strategy from card until reset. 
Use controller’s Reset button to save strategy to 
flash memory.2, 3

1 Controller must be on same network segment as PC.
2 CAUTION: Before resetting, make sure you know what is on the card! ALL IP address and configuration 
information, firmware, and strategy that exist on the card are saved to flash memory.
3 If you have firmware R9.x but a loader older than 6.x, the controller runs the new strategy from card until 
reset, but the strategy cannot be saved to flash memory.
4 CAUTION: Persistent variables will be deleted. 
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Storing and Accessing Data or Files

When inserted into the controller and accessed from a PC using FTP or PAC Control, the card appears as a 
directory in the controller’s file system named: sdcard0 Just like a PC might show a thumb drive as a 
directory named Removable Disk (E:), for example, the controller shows the card as a directory named 
sdcard0. 

IMPORTANT: Do NOT try to create this directory. When you look at the card in the controller, the card appears as 
a directory named sdcard0. When you look at the card in a card reader attached to your PC, you see the card reader’s 
directory instead. When the card is in a card reader, you are already in the root of the card (that is, you are already 
inside the sdcard0 directory).

For example, suppose you are looking at a card in a SNAP PAC controller with IP address 10.192.54.241. You 
can see that this controller has three files in its regular file system, plus the card:

Within the sdcard0 directory on the controller (or the root if the card is in a card reader), you can create 
other directories and create or add files. For a card formatted with FAT16, you can have up to 512 files or 
directories in the root directory, and each subdirectory can have up to 65,534 files. Cards formatted with FAT32 
have no restrictions on the number of files in the root. Note filename requirements in “Card Type and Format” 
on page 40.

When the card is in the controller, you can access files on the card through PAC Control commands and from a 
PC using FTP.

Use PAC Control commands just as you would with any other file in the controller’s file system. For help, see 
“Using the Control Engine’s File System” in the PAC Control User’s Guide (form 1700). Remember to include the 
card’s directory name in the path in the file communication handle, for example: 
file:a,/sdcard0/VoltLog.txt
Note that the path separator is a forward slash (/), not a backward slash (\). 

You can also use the FTP communication handle in PAC Control to manipulate files. See the section “Moving 
Files via FTP,” also in the PAC Control User’s Guide. 

To move files to or from a PC, use any standard FTP software. (Don’t use PAC Manager as the FTP client, as it 
cannot see directories within the controller’s file system). Remember to include the card’s directory name, for 
example: ftp://192.168.1.1/sdcard0/

microSD/SDHC cardFiles in PAC’s file system

https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
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NOTE: If you access the card when it is not in the controller (for example, in a card reader), the sdcard0 directory does 
not appear. Do NOT create it. The controller treats the card as a folder in the controller’s file system. 

Displaying Free Space on the Card

If you need to know how many free bytes are left on a microSD/SDHC card, you can use PAC Control or 
PAC Manager to read this data from an address in the controller’s memory map. In a PAC Control strategy, for 
example, you could notify an operator if the card needs replacing, based on the number of bytes still unused.
1. Make sure the card is in the controller.
2. In PAC Control, use the command Read Number from I/O Unit Memory Map to read memory map 

address F7002204. Use Integer 32 Variable in Argument 2. 
For more information, see “I/O Unit—Memory Map Commands” in the PAC Control User’s Guide, and see 
“Read Number from I/O Unit Memory Map” in the PAC Control Command Reference (form 1701).

3. In PAC Manager, open the Inspect window for the controller. Click Other and choose Generic Read/Write 
from the popup menu. In the Address field, type F7002204. From the Type list, choose 32-bit Integer. 
Leave the Length as 1. Click Refresh. 
The number of bytes appears in the Value column.

Checking Firmware and Loader Versions

Compatible cards and card functions depend on the controller’s firmware and loader versions. Here’s how to 
check them. The controller must be on the same network segment as the PC with PAC Manager.
1. Open PAC Manager and click the Inspect icon .
2. In the Device Name field, enter the controller’s name or IP address, or choose it from the drop-down list. 

Click Status Read.
Loader and firmware version numbers appear near the center of the window:

New firmware versions and some new loader versions are available from our website, www.opto22.com. 
To update the loader, see Updating the Loader on a SNAP Device (form 1789). For firmware, see “Loading 
New Firmware” on page 40. Contact Opto 22 Product Support with any questions.

https://www.opto22.com/support/resources-tools/documents/1700-pac-control-users-guide
https://www.opto22.com/support/resources-tools/documents/1701-pac-control-command-reference
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=3648
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Replacing a Controller

A microSD/SDHC card can be used to quickly commission a replacement controller in the unlikely event that 
an existing controller fails. The card rapidly configures the replacement with the original controller’s IP address, 
firmware, configuration, and strategy. 

Preparing the card requires PAC Manager R9.0 or higher. You must prepare the card in advance and then keep it 
in a safe place in case the controller fails.

The replacement controller must have exactly the same part number as the old controller (for example, a 
SNAP-PAC-S1 must be replaced by a SNAP-PAC-S1), and it must have minimum firmware R9.0a and loader 
6.0a. See page 43 to check versions.

CAUTION: Use the commissioning card only to replace a controller; it assigns the new PAC controller the same IP 
address as the old one. 

Prepare the Card In Advance. 
1. Put a blank card into the controller that you may need to replace.
2. Copy configuration data as follows:

a. Open PAC Manager if needed. In the main window, click the Inspect icon . 
b. In the Device Name field, type the name (or IP address) of the device. Click Status Write.
c. In the Operation Command list, highlight Store configuration and IP settings to microSD.

d. Click Send Command. 
The controller’s IP settings and all configuration data are saved to the card in a file located at 
/sdcard0/opto22/config/config.cfg.

3. Prepare the strategy file:
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a. Open your strategy in PAC Control. In Configure mode, choose FileStrategy Options. Click the 
Download tab.

b. Check the Set autorun flag after download box. Click OK.
c. Choose one of the following:

– If you’re using PAC Terminal Secure Strategy Distribution (SSD), follow the steps in PAC Terminal 
SSD Technical Note (form 1762, available with purchase of PAC Terminal SSD) to create a 
download file with the file extension .ssd. 

– Otherwise, compile the strategy as a Control Engine Download file (.cdf ) by right-clicking the 
name of the control engine in the Strategy Tree and choosing Compile Control Engine 
Download File from the pop-up menu. 

The file is created in the same folder as the strategy, with a .cdf extension and a filename consisting 
of the strategy’s name and the control engine’s name (for example, MyStrategy.MyEngine.cdf ).

d. (Firmware below R9.4a only): Rename the .cdf or .ssd strategy file to fit the 8 dot 3 filename format 
for the microSD card (see “Card Type and Format” on page 40).

IMPORTANT: You must retain the correct file extension (.cdf or .ssd).

4. Remove the card from the controller and put it in a card reader attached to the PC. Prepare the firmware 
file: 
a. Locate the firmware file you want to upgrade to.
b. (Firmware below R9.4a only): Rename the file to fit the 8 dot 3 filename format. 

For this file, do not keep the same file extension. Recommended naming scheme: PPP-TMM.mmb 
where:

Example of an original firmware filename: snap-pac-r2-R9.0a.bin
Example of the same firmware file, renamed: R2-R9.0a

5. Create the firmware command file: 
a. Using Notepad or a similar editor, create a text file named: command 

In the command file, type the following command (CASE SENSITIVE): 

PPP
T
MM
mm
b

= controller type (R1, R2)
= R for release (or B for beta)
= major revision number
= minor revision number
= build letter 

https://www.opto22.com/products/pactermssd
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Krn <file> 

<file> is the firmware path and filename as the card sees it, so do not include the sdcard0 directory 
in the path. If you’re using Secure Strategy Distribution, <file> must include a valid signature. Here is 
a sample command file:

b. In Windows Explorer, delete the .txt extension from the command file. Then right-click the 
command file filename and choose Properties. In the General tab, click to put a checkmark in the 
Read-only box. Click OK.

6. Copy files to the card: 
a. Copy the command file to the sdcard0 directory in the controller’s file system. 
b. Copy the firmware file to the sdcard0 directory. This directory must contain only one firmware 

file.
c. In the sdcard0 directory on the card, create a new directory and name it: strategy 

Copy the renamed strategy file (.cdf or .ssd) to the sdcard0/strategy directory.

The card is now ready to be used as a commissioning card to replace the controller. 

Replacing the Failed Controller. 

Before you start, make sure that the replacement controller:
• Has exactly the same part number as the old controller (for example, a SNAP-PAC-S1 must be replaced by 

a SNAP-PAC-S1)
• Has minimum firmware R9.0a and minimum loader R6.0a. To check firmware and loader versions in PAC 

Manager, see page 43. You can download new firmware from our website; if you need a newer loader, 
contact Product Support.

Follow these steps to replace the failed controller:
7. Turn off the controller that failed. Put the new controller in its place but DO NOT apply power. Attach 

network cables.
8. Insert the prepared microSD/SDHC card and turn on power to the controller. 
9. Without waiting, carefully insert a straightened paperclip or stiff wire into the small hole on the controller 

labeled RESET. Press and hold the Reset button just until the STAT LED turns solid green, and then 
immediately release the button.
The IP address is assigned to the controller, and firmware, configuration data, and strategy are loaded into 
RAM, in that order. 
– In firmware R9.2c and newer, IP address, firmware, configuration, and strategy are stored to flash and 

the controller reboots running the new firmware. The STAT LED blinks steadily during this process 
and then blinks two sets of three blinks—green to indicate success, or red to indicate failure. 

– In firmware R9.0–R9.2b, IP address, firmware and configuration are stored to flash and the controller 
reboots running the new firmware and loads the new strategy. To store the strategy to flash, use the 
Reset button again in exactly the same way. 

When finished, a folder named backup is placed in the root directory of the card. The controller 
restarts. 

10. Wait until the STAT LED blinks only once every five seconds, and then remove the card. 

Updating Firmware 

The card can also be used to update firmware if the controller is not on the network, or if PAC Manager isn’t 
available. 

Krn R2-R9.0a
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CAUTION: Before updating firmware, make sure you know what is on the card! Any IP address, configuration data, 
and strategy on the card will be saved to flash memory along with the firmware. If you want only the firmware saved, 
delete configuration and strategy files from the card. 

CAUTION: Updating firmware deletes your PAC Control strategy (even if stored to flash memory) and your 
persistent variables. Make sure you have archived your strategy before loading new firmware. 

1. Obtain the correct firmware file from our website, www.opto22.com. If you are using Secure Strategy 
Distribution (SSD), the firmware must have the correct signature. 

2. (Firmware below R9.4a only): Rename the firmware file to fit the 8 dot 3 filename format (see “Card Type 
and Format” on page 40). 
The original file extension does not have to be retained. To make sure the file is clearly identified, we 
recommend a name such as the following: PPP-TMM.mmb where:

Example of an original firmware filename: snap-pac-r2-R9.0a.bin
Example of the same firmware file, renamed: R2-R9.0a

3. Copy the firmware file to a blank card. If you don’t have a blank card, delete the following directories and 
their contents if they appear on the card: 

You can write to the card in one of two ways: either use your PC to FTP files to the card in the controller, or 
use a card reader with your PC and simply copy files with Windows Explorer. 

4. Using Notepad or a similar text editor, create a command file named command.txt and save it in the 
root directory of the card. (If you are looking at the card in a card reader, save it in the root directory. If you 
are looking at the card in the controller, save it in the directory named sdcard0 ). 

5. In the command file, include the following command. All commands are CASE SENSITIVE. 

The following sample command file updates firmware on the controller. 

PPP
T
MM
mm
b

= controller type (R1, R2)
= R for release (or B for beta)
= major revision number
= minor revision number
= build letter 

/sdcard0/strategy
/sdcard0/boot
/sdcard0/opto22/config

To do this Use command Details

Install controller 
firmware

Krn <file>

<file> is the firmware path and filename as the card sees it, 
so do not include sdcard0 directory in the path. The firm-
ware file can be compressed in gzip format or uncom-
pressed.* If you’re using Secure Strategy Distribution, 
<file> must include a valid signature. 
NOTE: Controller firmware will be installed only if it differs 
from the current firmware.

* To gzip a file on Windows, use the utility at http://gnuwin32.sourceforge.net/packages/gzip.htm. 
SNAP PAC cannot decompress files that were compressed with WinZip

Krn R2-R9.0a

http://gnuwin32.sourceforge.net/packages/gzip.htm
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6. In Windows Explorer, delete the .txt file extension from the file so that the complete filename is only: 
command Then right-click the command file and choose Properties. In the General tab, click to put a 
check in the Read-only box. Click OK.

CAUTION: Make sure you know what is on the card before updating firmware! Any IP address, configuration, 
or strategy data that exists on the card will also be saved to flash memory along with the firmware.

7. To update firmware, insert the card in the controller’s card slot. Carefully insert a straightened paper clip 
or stiff wire into the small hole on the controller labeled RESET. Press and hold the Reset button just until 
the STAT LED turns solid green, and then immediately release the button.
Firmware is updated and saved to flash memory. (If IP address, configuration, or strategy files are on the 
card, they are also saved to flash memory.) When finished, a file named response is placed in the root 
directory of the card; this file indicates the success or failure of commands in the command file. Then the 
controller restarts. 

8. Wait until the STAT LED blinks only once every five seconds, and then remove the card. 

Booting from Firmware on the Card

You can also boot the controller from firmware on the card, rather than from the firmware in flash memory, for 
example to test new firmware before updating it on the controller. 

You can write to the card in one of two ways: either use your PC to FTP files to the card in the controller, or use 
a card reader with your PC and simply copy files with Windows Explorer.

NOTE: Controllers configured for Secure Strategy Distribution (SSD) cannot boot from the card.

1. Locate the firmware file you wish to boot from. 
2. (Firmware below R9.4a only): Rename the file to fit the 8 dot 3 filename format (see “Card Type and 

Format” on page 40). 
Recommended naming scheme: PPP-TMM.mmb where:

Example of an original firmware filename: snap-pac-r2-R9.0a.bin
Example of the same firmware file, renamed: R2-R9.0a

3. Create a directory on the card in the root and name it: boot
Remember, if you are looking at the card in the controller, you create the boot directory in the 
sdcard0 directory. If you are looking at the card in a card reader, create the boot directory at the top 
level. The controller’s file system treats the card as a directory named sdcard0.

4. Copy the renamed firmware file to the sdcard0/boot directory on the card.
Here’s how it might appear if you are looking at the card in the controller:

PPP
T
MM
mm
b

= controller type (R1, R2)
= R for release (or B for beta)
= major revision number
= minor revision number
= build letter 
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IMPORTANT: The boot directory must contain only one firmware file. If it contains more than one, the wrong 
firmware may be loaded. 

5. If the card contains a command file or any other firmware files, delete them.
6. To boot the controller from firmware on the card, turn the controller off and insert the card in the 

controller’s card slot. Turn the controller back on. (Or insert the card and then quickly push and release 
the controller’s Reset button.)
If the boot directory exists on the card, the STAT LED blinks green three times, quickly. Firmware is loaded. 
If the STAT LED blinks red, see “Blink Codes” in this chapter to determine the problem. 
If the STAT LED blinks green two times, either the boot directory is not present, the firmware file is invalid 
or does not match the controller, or the controller is an SSD controller.
When the STAT LED no longer blinks steadily, but blinks only once every five seconds, you can remove the 
card. When the card is removed, the controller continues running the firmware on the card until power is 
cycled or the controller is reset. If you need to know whether the controller booted from the card or from 
flash memory, use PAC Manager’s Inspect window to check the Status Read area. See the PAC Manager 
User’s Guide for instructions.

Updating, Running, or Testing a Strategy

The card can also be used to update, run, or test a PAC Control strategy. This ability is useful when the 
controller is not on the network or PAC Control isn’t available. Both regular strategies and Secure Strategy 
Distribution (SSD) strategies can be used. 

You can write to the card in one of two ways: either use your PC to FTP files to the card in the controller, or use 
a card reader with your PC and copy files with Windows Explorer.

CAUTION: Before saving to flash memory, make sure you know what is on the card! ALL IP address, configuration 
data, and firmware on the card will be saved to flash along with the strategy. If you want only the strategy saved, 
delete configuration and firmware files from the card. 

1. In PAC Control Configure mode, choose File >Strategy Options. Click the Download tab.

https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
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2. If you want to set the strategy to autorun, check the box Set autorun flag after download. 
Autorun works if you insert the card and then turn on the controller; it has no effect if you insert the card 
when the controller is already turned on. (If the controller is already turned on, the new strategy follows 
the status of the existing strategy: if the existing strategy was running when the card was inserted, the 
new strategy will run; otherwise, it will not.)
If you use background downloading, the controller will switch to the new strategy when the card is 
inserted. 

3. Click OK.
4. Choose one of the following:

a. If you’re using PAC Terminal Secure Strategy Distribution (SSD), follow the steps in PAC Terminal SSD 
Technical Note (form 1762, available with purchase of PAC Terminal SSD) to create a download file 
with the file extension .ssd. 

b. Otherwise, compile the strategy as a Control Engine Download file (.cdf ) by right-clicking the name 
of the control engine in the Strategy Tree and choosing Compile Control Engine Download File from 
the pop-up menu. 
The file is created in the same folder as the strategy, with a .cdf extension and a filename consisting 
of the strategy’s name and the control engine’s name (for example, MyStrategy.MyEngine.cdf ).

5. (Firmware below R9.4a only): Rename the .cdf or .ssd strategy file to fit the 8 dot 3 filename format for the 
microSD card (see “Card Type and Format” on page 40). 

IMPORTANT: You must retain the correct file extension (.cdf or .ssd).

6. Create a directory on the card in the root and name it: strategy 
Remember, if you are looking at the card in the controller, you create the strategy directory in the 
sdcard0 directory. If you are looking at the card in a card reader, create the strategy directory at 
the top level. The controller’s file system treats the card as a directory named sdcard0. 

7. Copy the renamed strategy file to the sdcard0/strategy directory on the microSD card.
Here’s an example of a strategy file in the strategy directory, looking at the card in the controller:

https://www.opto22.com/products/pactermssd
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8. If you plan to save the strategy to flash memory, delete the following files and directories if they are on 
the card: 

NOTE: If the controller has firmware R9.0a or newer and a loader version older than R6.0a, you cannot save the 
strategy from the card to flash memory. 

9. To update, run, or test the strategy, turn off the controller, put the card in, and turn the controller back on. 
The controller loads the strategy from the card (verifying the signature if it is an .ssd file), switches to the 
new strategy if you’re using background downloading, and runs the new strategy if you set it to autorun. 
If it’s not set to autorun, you can start the strategy manually using PAC Control or PAC Terminal. 
The STAT LED blinks steadily while the strategy is loading and then blinks two sets of three blinks—green 
to indicate success, or red to indicate failure. When the STAT LED no longer blinks steadily, but blinks only 
once every five seconds, it has finished. 

10. If you want to save the strategy to flash memory, carefully insert a straightened paperclip or stiff wire into 
the small hole on the controller labeled RESET. Press and hold the Reset button just until the STAT LED 
turns solid green, and then immediately release the button.
The strategy is saved to flash memory. (If IP address, configuration, or firmware files are on the card, they 
are also saved to flash memory.) Then the controller restarts. 

11. Wait until the STAT LED blinks only once every five seconds, and then remove the card. 

Disabling or Enabling Firmware and Strategy Updates Via the Card

If you do not want anyone to be able to update firmware or strategies using a microSD/SDHC card, you can 
disable this feature in the controller. (Enabled is the default.)
1. In PAC Manager, open the Inspect window for the controller. 
2. Click Other and choose Generic Read/Write from the popup menu.
3. In the Address field, type F7002200. Choose 32-bit Integer as the Type. 
4. To disable firmware/strategy updates: In the Value column next to the address, type 0 (zero). Click 

Apply.

Command file and firmware files
/sdcard0/boot
/sdcard0/opto22/config

Strategy file
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5. To enable firmware/strategy updates: In the Value column, type any value other than zero and click 
Apply. 

Setting Time and Date

The SNAP PAC S-series controller’s built-in clock is set at the factory. To change the time and date, see the 
instructions in the PAC Manager User’s Guide.

STAT LED Blink Codes 

The STAT LED on the top of the SNAP PAC S-series controller uses blink codes to indicate controller operation 
and status conditions. The blink codes can be useful during normal operation and when troubleshooting.
• When the STAT LED steadily glows green it indicates that one or more flowcharts are running. 
• When the STAT LED steadily glows orange, it means the controller is on, and either:

– There isn't any strategy in the controller, or
– The strategy in the controller is stopped, or
– The strategy in the controller has run, and no flowcharts are currently running.

If your S-series PAC has a microSD card slot, the STAT LED:
• Briefly blinks off once every five seconds when it checks to see if a card has been inserted into the card 

slot. 
• Rapidly blinks when it is reading or writing to the card. 

For more information on microSD, see “Using the microSD Card Slot” on page 40. 

Different blink codes can occur in sequence. For example, two fast green blinks followed by three slow red 
blinks show the firmware loading at startup followed by a firmware error.

If the STAT LED blinks green when the controller starts up, it indicates the following:

If the STAT LED is blinking orange, it indicates the following:

If the STAT LED blinks red and green alternately, it indicates the following:

Number of
Blinks

Speed of
Blinks

Means

2 fast Loading firmware (kernel) from Flash memory to SDRAM.

5 fast Default settings have been successfully restored.

7 fast
(Loader versions 5.1n and older) Entering failsafe bootloader mode (see “Resetting 
the Controller” on page 39).

Number of
Blinks

Speed of
Blinks

Means

(continuous) slow* There is a problem with the bootloader. Contact Product Support.

(continuous) fast
No IP address is assigned to the controller. This may also indicate the 
controller is in hardware test mode.

* About once per second

Number of
Blinks

Speed of
Blinks

Means

(continuous) fast
(Loader versions 5.1c and newer) Entering fail-safe bootloader mode. (See 
“Resetting the Controller” on page 39.)

https://www.opto22.com/support/resources-tools/documents/1704-pac-manager-users-guide
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If the STAT LED is blinking red, it indicates the following:

Serial Port LEDs

The S0, S1, and S2 LEDs on a SNAP-PAC-S1 controller indicate serial port operation as follows:
• Green—Transmit
• Red—Receive
• Amber—Transmit and Receive (the LED is actually changing rapidly between green and red, which 

appears amber) 

Each serial port on a SNAP-PAC-S2 has two green LEDs to indicate Transmit and Receive activity for that port.

Number of
Blinks

Speed of
Blinks

Means Problem and Workaround

2 slow Flash programming failure
Flash chips failed to erase properly or program 
properly. Contact Product Support. 

3 slow Firmware CRC check failed.
The firmware in the device is damaged. See 
Replacing Damaged Firmware in chapter 6 of the 
PAC Manager User’s Guide (form 1704).

4 slow
Invalid MAC address or 
hardware revision.

Contact Product Support.

5 slow Fatal error
Firmware or hardware problem. Check the power 
supply and connections before restarting. Call Product 
Support if the error is repeated.

6 slow RAM error Contact Product Support.

7 slow Loader problem

Firmware or hardware problem. Confirm Ethernet 
cables are connected. Try turning off power to the 
controller and turning it back on again. Call Product 
Support if the error is repeated.

8 slow WLAN failure

(Wired+Wireless models only) Try restoring the PAC 
to factory defaults (see “Resetting the Controller” on 
page 39). If that doesn’t work, contact Product Sup-
port.

11 slow
Firmware failed to initialize 
communications on ENET 1.

Contact Product Support.

12 slow
Firmware failed to initialize 
communications on ENET 2.

Contact Product Support.

13 slow Real-time clock failure Contact Product Support.

16 slow Serial EEPROM failure Contact Product Support.

17 slow Serial port 0 failure Contact Product Support.

18 slow Serial port 1 failure Contact Product Support.

19 slow Serial port 2 failure

This error appears if your PAC-S has a microSD card 
slot and you are using firmware R8.2 or lower. Follow 
steps in the PAC Manager User’s Guide (form 1704) 
to install firmware version R8.3 or higher using Install 
Firmware via Failsafe Bootloader Mode.

21 slow I/O expander failure (PAC-S2) Contact Product Support.

22 slow Serial port 3 failure (PAC-S2) Contact Product Support.

23 slow Watchdog reset failure Contact Product Support.

http://www.opto22.com/site/documents/drilldown.aspx?aid=3161
http://www.opto22.com/site/documents/drilldown.aspx?aid=3161
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A: Technical Specifications

Processor 266 MHz 32-bit ColdFire® 5475 with integrated floating-point unit (FPU)

Memory

SNAP-PAC-S1 and SNAP-PAC-S2
Total RAM: 32 MB
Total RAM for PAC Control Strategies: 16 MB
Battery-backed RAM: 8 MB
RAM File Storage: 2.5 MB
Flash File Storage: 4 MB

Removable storage

(Models with manufacture dates of June 2014 and newer. Requires firmware 
R9.4a or higher and loader R6.1a or higher) MicroSD card slot: supports 
microSD or microSDHC cards to 32 GB. 
(Models with manufacture dates of November 2008 through May 2014 with 
firmware R8.4 or higher) microSD card slot: supports microSD cards up to 2 
GB.

Backup battery

SNAP-PAC-S1s with serial number 625654 or higher and all SNAP-PAC-S2s: 
Rechargeable (recharges whenever the brain has power), 1-year power-off 
data retention (replacement part number: SNAP-PAC-BATTERY-ML2430).
SNAP-PAC-S1s with serial number 625653 or lower: User-replaceable 3.6-volt 
TL 5242 /W lithium, 10-year minimum power-off data retention (replacement 
part number: G4BATT32).

Ethernet Communication to 
host and I/O

Two independent 10/100 Mbps Ethernet network interfaces (RJ-45 connec-
tors). Each interface has a separate IP address (separate subnet). Supports 
Auto MDI-X (crossover cable not needed).

Serial Communication

SNAP-PAC-S1
RS-232 serial: Two RS-232 serial ports (one DB-9 and one pluggable connec-
tor); one port has full handshaking. PPP is supported only on port 0. Buffer 
size: 512 bytes each for RX and TX.
RS-485 serial: One RS-485 serial port (pluggable connector); two-wire 
RS-485; optional mistic signal interrupts. Range (serial multidrop): 32 stations 
maximum on a segment (including PC, controller, and I/O units); up to 3000 ft 
(914 m) on a segment. Buffer size: 512 bytes each for RX and TX.

SNAP-PAC-S2
Four serial ports that can be used as general purpose ports or for serial I/O 
units; each port is software configurable as either RS-232 (Tx, Rx, COM, DTR, 
DCD, RTS, CTS) or as RS-485 (2-wire, 4-wire, optional termination, optional 
biasing); optional mistic signal interrupts. Buffer size: 512 bytes each for RX 
and TX.

Power requirements
8–32 VDC ±0.5, 11.3 VA maximum
(SNAP-PAC-S1 controllers with serial numbers below 500,000 use 8–24 VDC)
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Operating temperature
Storage temperature
Humidity

-20 °C to 60 °C
-40 °C to 85 °C
0% to 95% relative humidity, non-condensing

Software
PAC Project Basic

PAC Project Professional

RESTful API*

Includes programming, HMI software, and configuration software; included 
with purchase of controller.
PAC Project Basic plus OPC 2.0-compliant OPC server, OptoControl strategy 
and OptoDisplay project importing, support for serial mistic I/O units, and 
Ethernet link redundancy support.
Use HTTPS to access data (read/write or read-only) from controller tags using 
your chosen programming language. Data returned in JSON. More informa-
tion at developer.opto22.com

Number of charts that can 
run simultaneously

32

Other features

Multiple protocol support including TCP/IP, HTTP/HTTPS, FTP, SNMP v2.0c 
(with firmware 8.2a), Modbus/TCP, EtherNet/IP™, and OptoMMP™
Real-time clock
FTP server/client with file system (in RAM and in removable storage)
Ethernet link redundancy or network segmenting

Agency certifications All models: CE, RoHS, DFARS; UKCA

Warranty 30 months from date of manufacture

* Requires firmware R9.5a or higher
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assigning IP address, 26

B
backup battery, 38, 55
bias and termination, PAC S1, 18

switches, 20
blink codes, 52
brains supported, 3

C
changing IP address, 39
compatibility

brains, 3
I/O units, 3

connectors
PAC S1, 20
PAC S2, 21

controller information, getting, 38
controller, redundant, 3, 10
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data, accessing via API, 5
developers, 5
DIN-rail mounting, 27, 29, 30

dimensions
PAC S1, 29
PAC S2, 30

DIP switches, PAC S1, 18, 20
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environmental requirements, 55
Ethernet network, 1

certification, 35
errors, 35
interfaces, 20, 26
troubleshooting, 34

F
FactoryFloor, 3
failsafe bootloader mode, 39
files, in removable storage, 42
firmware

booting from microSD card, 48
disabling/enabling microSD updates, 51
getting information, 38
loading, 40
updating from microSD card, 46

H
hardware test mode, 39
help

network problems, 34
troubleshooting, 33

I
I/O units supported, 3
indicators

PAC S1, 20
PAC S2, 21

interrupt line
PAC S2, 23, 24

IP address, assigning, 26
IP address, changing, 39

J
JSON, 5
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L
LED blink codes, 52
LEDs, 20

PAC S1, 20
PAC S2, 21
serial port, 53
STAT, 52

legacy control hardware, 3
loading firmware, 40

M
memory, 55
memory map, 31
microSD card

booting from card, 48
card type and format, 40
disabling/enabling updates via card, 51
replacing controller, 44
storing data, 42
updating firmware from card, 46
updating strategy, 49

mode, termination, and bias, 18
modem, 8, 17
mounting

DIN-rail, 29
panel, 27

N
network, 1

basic diagram, 5
certification, 35
Ethernet errors, 35
packet sniffer, 35
redundant controllers, 3, 10
redundant Ethernet links, 1, 9
segmented, 1
troubleshooting, 34

network protocol analyzer, 35
networking

serial, 17

O
OPC, 12
operating temperature, 55
OptoControl strategies, 3
OptoMMP Communication Toolkit, 31

P
PAC Control, 49
PAC Manager, 12, 18
PAC S1. See SNAP-PAC-S1
PAC S2. See SNAP-PAC-S2
packet sniffer, 35
panel mounting, 27
peer-to-peer communication, 31
pinouts

PAC S1, 20
PAC S2, 21

power requirements, 55
power supply, 15
PPP communication, 2, 8, 11, 26
processor, 55
product support, 13
PSTN, 2

R
redundant controllers, 3, 10
redundant Ethernet links, 1, 9
replacing controller, 44
requirements for installation, 15
reset button, 39
resetting the controller, 39
RESTful API, 5
restoring factory defaults, 39
retransmit timeout (RTO), 35
RS-232, 2, 17, 26
RS-485, 2, 17, 26
RS-485, PAC S1

bias and termination, 18

S
Scratch Pad, 31
sdcard0, 42
segmented network, 1
serial networking, 17
serial number, 16
serial port LEDs, 53
serial ports, 2, 17

PAC S1, 18
PAC S2, 18, 19

assigning, 26
serial-based I/O units, 3, 7, 8
SNAP PAC SB-Series Brain, 22, 25
SNAP-PAC-S1

dimensions, 27
DIN-rail mounting and dimensions, 29
DIP switches, 18
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LEDs, 20
panel mounting, 27
serial ports, 18
termination settings, 17
wiring, 18
wiring diagrams, 22

SNAP-PAC-S2
dimensions, 28
DIN-rail mounting and dimensions, 30
interrupt line, 23, 24
LEDs, 21
mistic brain, connecting to, 23, 24
mode, termination, and bias, 18
panel mounting, 28
serial ports, 18, 19
wiring, 19

specifications, 55
STAT LED, 52
storage temperature, 55
strategy, 49

disabling/enabling microSD updates, 51
system requirements, 15

T
TCP/IP

networks, 2
settings, 35
stack, 35

temperature and humidity, 55
termination settings, SNAP-PAC-S1, 17
timeout, 35
troubleshooting, 33

network, 34

U
utilities, packet sniffer, 35

V
voltage range, 15

W
wireless LAN

specifications, 55
wiring

SNAP-PAC-S1, 18, 22
SNAP-PAC-S2, 19
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